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ВВЕДЕНИЕ 
 

 
 
 

В настоящее время к подготовке бакалавров, инженеров и магистров по сертификации и управлению качеством предъ-
являются высокие требования в области автоматизации измерений, контроля и испытаний. Одним из обязательных элемен-
тов освоения данной предметной области является приобретение навыков практического использования систем автоматиче-
ского проектирования различных компьютерных контрольно-измерительных систем (ККИС). Язык LabVIEW (Laboratory 
Virtual Instrument Engineering Workbench) разработан фирмой «National Instruments». Фирмой выпускаются разнообразные 
интерфейсные устройства, встраиваемые в компьютер или подключаемые к его портам, устройства генерации и обработки 
реальных электрических сигналов, датчики, регистрирующие различные физические процессы, и т.п.  

Язык LabVIEW не похож на другие языки программирования.  
С его помощью создается не программа, как мы привыкли ее представлять, а виртуальный инструмент, предназначен-

ный не только для моделирования тех или иных процессов, но и для управления аппаратными средствами и исследования 
реальных физических объектов. Простота образных графических конструкций, наглядность и читаемость готовых программ 
заставляют отдать предпочтение языку LabVIEW перед другими. Он подобен таким системам, как С++ или Basic, однако в 
отличие от них оперирует не кодовыми строками, а блоками диаграмм, что делает программирование более простым и по-
нятным. 

Преимущества этого языка проявляются при выполнении следующих задач: 
− исследование возможности контроля измерительной системой параметров объекта измерений; 
− анализ и оптимизация структуры ККИС; 
− расчет и анализ статистических и динамических метрологических характеристик (МХ) ККИС и ее компонентов. 
Построенные с использованием данного пакета имитационные модели наглядно отражают суть реальных физических 

процессов, протекающих в объектах исследования. LabVIEW включает большой выбор библиотек программ, позволяющих: 
–   управлять доступом к внешним данным посредством стандартных интерфейсов (КОП, VXI, RS232, USB и др.); 
–   анализировать данные измерений; 
–   осуществлять архивацию и хранение данных. 
На кафедре «Автоматизированные системы и приборы» ТГТУ с использованием данной системы программирования 

разработан ряд практических занятий и лабораторных работ. Задачей этих занятий является освоение студентами основ по-
строения моделей средств измерений, проведение имитационного моделирования процессов измерения и контроля, а также 
привитие обучаемым навыков работы с объектно-ориентированным программным обеспечением. 

В ходе проведения лабораторных занятий студенты приобретут практический опыт автоматизации процесса измерений, 
навыки работы с виртуальными приборами, умение формирования из отдельных средств измерений пространственно-
распределенной ККИС на базе стандартных интерфейсов и модулей серий ADAM-4000 и I-7000, проведут измерения таких 
типовых технологических параметров, как температура, влажность, число оборотов, скорость и т.п. 

Студенты получат навыки измерений, контроля и испытаний свойств материалов на удаленных объектах автоматизации 
с использованием сетевых возможностей LabVIEW и Интернета.  

Сложность выполнения заданий по вариантам возрастает от занятия к занятию. Учебное пособие построено таким обра-
зом, чтобы по окончании курса занятий обучаемые имели достаточный уровень знаний по автоматизации измерений, кон-
троля и испытаний и навыков работы с интерфейсом программной среды LabVIEW. 

В разработке и сборке лабораторных стендов для учебных занятий № 10 – 12 приняли участие магистранты кафедры 
«Автоматизированные системы и приборы» ТГТУ С.Н. Мочалин и Е.Н. Ковалев.  

 



 

1. ВВЕДЕНИЕ В LabVIEW.  
ОСНОВНЫЕ ПОНЯТИЯ И ПРАВИЛА  

ПОСТРОЕНИЯ ВИРТУАЛЬНЫХ ПРИБОРОВ 
 

 
 

Занятие  № 1 
 

ИЗУЧЕНИЕ ОСНОВНЫХ ПОНЯТИЙ ПРОГРАММНОЙ СРЕДЫ  
LabVIEW И ВИРТУАЛЬНОГО ПРИБОРА 

 

Программа, написанная в среде LabVIEW, называется виртуальным прибором (ВП). ВП симулируют реальные физиче-
ские приборы. LabVIEW содержит полный набор инструментов для сбора, анализа, представления и хранения данных. 

Запуск среды программирования LabVIEW осуществляется либо двойным кликом мыши на ярлыке LabVIEW, который 
находится на рабочем столе, либо из раздела Пуск-Программы – National Instruments LabVIEW. При входе в главное меню 
LabVIEW пользователю предлагается создание нового виртуального инструмента (New VI) или открытие уже существующе-
го (Open VI). 

ВП состоит из четырех основных компонентов – лицевой панели, блок-диаграммы, иконки и соединительной панели. 
Разработка VI (ВП) осуществляется на двух панелях, находящихся в двух окнах, – передней (лицевая панель) и функ-

циональной (блок-диаграмма). Лицевая панель − интерфейс пользователя создается с использованием палитры Элементов 
(Controls). Эти элементы могут быть либо средствами ввода данных – элементы управления, либо средствами отображения 
данных – элементы отображения. Элементы управления – кнопки, переключатели, ползунки и другие элементы ввода. 
Элементы отображения – графики, цифровые табло, светодиоды и т.д.  

После этого на блок-диаграмме ВП осуществляется программирование с использованием палитры Функций (Functions), 
которая включает графическое представление функций для управления объектами на лицевой панели. 

Структура панелей одинакова. Основным элементом каждой панели является рабочая 
область, снабженная горизонтальным и вертикальным скролингами, в которой и размеща-
ются элементы. Также на панелях имеются верхнее меню и набор управляющих кнопок (рис. 

1.1): 
• кнопка «стрелка» – пуск выполнения программы; если в 

программе имеются ошибки, то данная кнопка расколота на две 
части; 

• кнопка «стрелки в цикле» – запуск программы в цикли-
ческом режиме; 

• кнопка «красный круг» – остановка выполнения программы; 
• кнопка «две вертикальные черты» – пауза в выполнении программы. 
Для обеих панелей доступна панель Tools Palette (рис. 1.2), включающая набор управляющих 

кнопок для изменения режима редактирования. Перечислим некоторые из них: 
• кнопка «указательный палец» служит для изменения позиций выключателей и кнопок, 

управления значениями цифровых регуляторов, настройки виртуальных осциллографов и др.; 
• кнопка «стрелка» – выделение, перемещение объектов, изменение их размера; 
• кнопка «А» – открытие и редактирование текстового окна; 

• кнопка «катушка» служит для соединения объектов на функциональной панели; 
• кнопка «кисть» – раскрашивание объектов или фона; 
• кнопка «рука» – перемещение рабочей области панели в окне; 
• кнопка «пипетка» – выбор текущего цвета из имеющихся на панели; 

• кнопка «красный круг» – для размещения и снятия точек остановки выполнения програм-
мы на функциональной панели; 

• кнопка «Р» – для размещения на функциональной панели локальных окон для отображе-
ния текущих значений данных, передаваемых в ходе выполнения программы. 

При активной передней панели становится доступной панель Controls (рис. 1.3), которая вы-
зывается либо щелчком правой кнопки мыши в рабочем пространстве лицевой панели, либо необ-
ходимо выбрать в пункте главного меню Window → Show Controls Palette. С ее помощью осущест-
вляется визуальное размещение элементов управления и элементов отображения на лицевой па-
нели ВП. В панели Controls они распределены по отдельным группам по некоторым признакам – 
числовые, логические, строковые, массивы, диалоговые, ActivX, Internet и др. 

Рассмотрим основные подпанели панели Controls: 
• Numeric (числовые значения). Состоит из элементов управления и элементов отображения 

для числовых данных; 
• Boolean (булевы значения). Состоит из элементов управления и элементов отображения 

для булевых величин; 
• String&Table (строковые значения и таблицы). Состоит из элементов управления и элемен-

тов отображения для ASCII строк и таблиц;  
• List & Ring (списки и закольцованные списки). Состоит из элементов управления и элементов отображения для ме-

ню, выполненных в форме списков и закольцованных списков; 

 
 
 
 

 
 

Рис. 1.1. Управляющие 
кнопки 

 
 

Рис. 1.2. Панель Tools 

 
 

Рис. 1.3. Панель  
Controls 



 

• Array & Cluster (массивы и кластеры). Состоит из элементов управления и элементов отображения для группировки 
наборов типов данных; 

• Graph (виртуальные осциллографы). Состоит из элементов отображения для построения графиков данных в графах 
или диаграммах в реальном масштабе времени; 

• Path & Refnum (пути и ссылки). Состоит из элементов управления и элементов отображения для путей и ссылок; 
• Decorations (оформление). Состоит из элементов управления и элементов отображения графических объектов для на-

стройки дисплеев лицевой панели; 
• Select Control (выбор регулятора). Отображает диалоговое окно для загрузки самодельных элементов управления; 
• User Controls (средства управления пользователя). Состоит из специальных средств управления, которые формирует сам 

пользователь; 
• ActiveX (объекты ActiveX). Состоит из средств управления, позволяющих внедрить объекты ActiveX на лицевую 

панель; 
• Dialog (диалоговая панель). Состоит из стандартных объектов для формирования диалога с пользователем; 
• IMAQ Vision (обработка изображений). Состоит из средств обработки и анализа изображений; 
• Internet Toolkit (работа с Internet). Состоит из средств управления, располагаемых на передней панели, позволяющих 

организовывать работу виртуальных инструментов в сети Internet (ftp, электронная почта, telnet, CGI и другие). 
После помещения элементов управления или отображения данных на лицевую панель они получают свое графическое 

отображение (в виде терминала данных) на блок-диаграмме. Символы на терминале соответствуют 
типу данных терминала. Например, DBL – терминал представляет данные в виде вещественных чи-
сел с двойной точностью, TF – логический терминал, I16 – терминал 16-битных целых и др.  

При активировании функциональной панели становится доступной палитра Functions (рис. 
1.4), которая аналогично панели Controls включает систематизированные наборы стандартных 
элементов в виде отдельных пиктограмм, из которых осуществляется составление блок-схемы ВП. 
Палитра Functions вызывается либо щелчком правой кнопки мыши в рабочем пространстве блок-
схемы, либо путем выбора в пункте главного меню Window → Show Function Palette. 

Рассмотрим основные подпанели панели Functions:  
• Structures (структуры). Состоит из управляющих структур программы, таких как циклы 

For Loop, While Loop и др.; 
• Numeric (числовые функции). Состоит из тригонометрических, логарифмических и других 

функций; 
• Boolean (булевы функции). Состоит из логических и булевых функций; 
• String (строковые функции). Состоит из функций для работы со строковыми величинами; 
• Array (массивы). Состоит из функций для обработки массивов; 
• Cluster (кластеры). Состоит из функций для обработки кластеров; 
• Comparison (сравнение). Состоит из функций для сравнения переменных; 
• Time & Dialog (время и диалог). Состоит из функций для диалоговых окон, синхронизации 

и обработки ошибок; 
• File I/O (ввода/вывода файла). Состоит из функций для осуществления операций по вво-

ду/выводу файлов; 
• Instrument I/O (инструменты ввода/вывода). Состоит из ВП для связи и управления прибо-

рами различной архитектуры; 
• Instrument Drivers (драйверы приборов). Состоит из ВП, способных управлять внешними 

приборами, осциллоскопами, генераторами и т.д., через последовательный порт или интерфейс 
GPIB; 

• Data Acquisition (сбор данных). Состоит из ВП для использования плат сбора данных; 
• Signal Processing (обработка сигналов). Состоит из ВП для генерации и обработки сигналов; 
• Mathematics (математические). Состоит из оптимизационных, алгебраических, интегральных, дифференциальных и 

других функций; 
• Graphics & Sound (графика и звук). Состоит из ВП для работы с трехмерной графикой, изображениями и звуком; 
• Communication (связи). Состоит из виртуальных приборов для работы с сетями TCP, DDE и др.; 
• Application Control (управление приложением). Состоит из ВП, управляющих виртуальными приборами; 
• Advanced (расширенная). Состоит из разных функций типа функции библиотечного запроса, манипуляции данных и 

др.; 
• Report Generation (генерация отчета). Состоит из ВП, используемых для подготовки отчетных документов; 
• Tutorial (обучающие программы). Состоит из ВП, используемых в обучающей программе LabVIEW; 
• User Libraries (пользовательские библиотеки). С помощью нее организуется быстрый доступ к нужному vi; 
• Select VI (выбор ВП). Состоит из диалогового окна для внедрения подпрограмм в текущий ВП; 
• IMAQ Vision (обработка изображений). Состоит из ВП, используемых для обработки и анализа изображений; 
• Image Acquisition (получение изображения). Состоит из ВП, используемых для получения и обработки изображений; 
• Internet Toolkit (работа с Internet). Состоит из ВП, используемых для работы в сети Internet (ftp, электронная почта, telnet, 

CGI и др.); 
• SQL (SQL запросы). Состоит из ВП, используемых для организации связи с SQL сервером и обработки запросов. 

 
 

Рис. 1.4. Панель  
Functions 



 

Объекты блок-диаграммы включают графическое отображение элементов лицевой панели, операторов, функций, под-
программ ВП, констант, структур и проводников данных, по которым производится обмен данными между объектами блок-
диаграммы. 

Проводники данных между терминалами аналогичны переменным на обычных языках. Данные идут в только одном на-
правлении, с исходного терминала на один или более терминалов адресата. Провода имеют различную толщину и цвет. Си-
ний цвет соответствует целым числам, оранжевый – вещественным числам, зеленый – логическим, лиловый – строковым 
данным и т.д. 

При нажатии правой кнопки мыши на регуляторе/индикаторе (как на передней, так и на функциональной панели) появ-
ляется контекстное меню, с помощью которого возможно осуществить:  

• замену элемента управления (регулятора) на элемент отображения (индикатора) и наоборот (Change to Control, 
Change to Indicator);  

• быстрый поиск терминала на функциональной панели (Find Terminal) и регулятора/индикатора на передней панели 
(Find Control, Find Indicator);  

• демонстрацию или отказ от названия для описания регулятора/индикатора (Show → Label, Show → Caption);  
• настройку параметров регулятора/индикатора (Data Operations);  
• замену на другой регулятор/индикатор (Replace);  
• получение справки по используемой функции (Online Help);  
• открытие для функций соответствующих им констант, индикаторов и регуляторов (Create Constant, Create Indicator, Create 

Control) и др. 
 

Задание  1.1.  ВП Частотный анализ 
 

1.   Запустите LabVIEW Пуск → Программы → NationaI Instruments → LabVIEW 7.0 → LabVIEW. Появится диалоговое 
окно LabVIEW. 

2.   Выберите Help → Find Examples. На экране появится диалоговое окно поиска примеров ВП, разбитых по категори-
ям. 

3.   Перейдите на закладку Browse (Обзор). Отметьте пункт Directory Structure. Выберите Apps, Freqresp.Ilb и дважды 
щелкните на Frequency Response.VI (Частотная характеристика). Появится лицевая панель ВП «Частотный анализ» (рис. 1.5). 

 

 
 

Рис. 1.5. ВП «Частотный анализ» 

4.   С помощью инструмента УПРАВЛЕНИЕ измените значение установки  амплитуды Amplitude. Изменить значе-
ние можно либо переместив указатель кнопки в нужное положение, либо используя стрелки изменения значений элемента 
управления, либо введя число непосредственно в дисплей элемента. 

 Если число введено непосредственно в дисплей элемента, то необходимо нажать кнопку Enter, показанную слева, 
появившуюся на инструментальной панели. Иначе число не будет введено. 

5.   Нажать кнопку Run и запустить ВП. Изменяя значения других средств управления, находящихся на панели, иссле-
довать работу ВП. 

 

Блок-диаграмма 
 

6.   Перейдите на блок-диаграмму. Для этого выберите в главном меню Window → Show Diagram или введите <Ctrl–E> 
с клавиатуры. 

7.   Откройте окно контекстной справки, выбрав в пункте главного меню Help → Show Context Help. Получить инфор-
мацию об объекте в окне контекстной справки Context Help можно, наведя на них курсор; 

а)  Поместите инструмент ПЕРЕМЕЩЕНИЕ  над функцией Logarithm Base 10, расположенной под меткой Bode 
Plot. В окне контекстной справки Context Help появится описание функции; 



 

б)  В окне контекстной справки Context Help нажмите кнопку More Help  для перехода в соответствующий раздел 
LabVIEW Help (Встроенной Помощи). Можно также щелкнуть по ссылке Click here for more help окна контекстной справки 
Context Help. 

LabVIEW Help (Встроенная Помощь) содержит подробное описание палитр, меню, инструментов, ВП и функций. Здесь 
можно получить подробное описание и других функций; 

в) Наведите инструмент СОЕДИНЕНИЕ  на поля ввода/вывода данных функции Logarithm Base 10. Соответст-
вующие поля в окне контекстной справки Context Help начнут мигать; 

г) Переместите инструмент СОЕДИНЕНИЕ на проводник данных. В окне контекстной справки Context Help появится 
описание типа данных в проводнике.  

8.   Чтобы зафиксировать текущее окно Context Help (контекстной справки), необходимо либо нажать кнопку , либо 
выбрать в пункте главного меню Help → Lock Context Help. Когда текущее окно Context Help (контекстной справки) зафик-
сировано, то его содержимое не меняется после наведения курсора на другой объект. Для отмены фиксации следует нажать 
кнопку второй раз. 

Контрольные вопросы 
 

1. Из каких основных компонентов состоит ВП? 
2. Что понимается под интерфейсом пользователя ВП? 
3. Какие палитры доступны для лицевой панели? 
4. Какие палитры доступны для блок-диаграммы? 
5. Что представляет собой лицевая панель? 
6. Каково назначение блок-диаграммы? 
7. Из каких подпалитр состоит палитра Controls (Элементов)? 
8. Из каких подпалитр состоит палитра Functions (Функций)? 
9. На каких панелях осуществляется разработка ВП? 
10. Назовите назначение управляющих кнопок на блок-диаграмме. 
11. Назовите назначение управляющих кнопок на лицевой панели. 
12. Что такое элемент управления и элемент отображения? 
13. Назовите основные типы данных. 
14. Что такое проводник данных? 
15. Каким образом осуществляется вызов контекстной справки? 
16. Как можно зафиксировать текущее окно контекстной справки? 
17. Назовите назначение контекстного меню. 
 

Занятие  № 2 
 

СОЗДАНИЕ, РЕДАКТИРОВАНИЕ И ОТЛАДКА  
ВИРТУАЛЬНОГО ПРИБОРА  

 

Цель занятия: 
• изучить компоненты ВП; 
• создать ВП (преобразовать °С в °F);  
• изучить типы данных и проводники данных; 
• отредактировать ВП; 
• приобрести практические навыки отладки ВП. 
 

ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 
 

 

 Объекты лицевой панели на блок-диаграмме отображаются в виде терминалов данных (графическое изображение 
прямоугольной формы с буквенно-численными обозначениями). Терминалы данных обеспечивают обмен данными между 
лицевой панелью и блок-диаграммой; они подобны переменным и константам текстовых языков программирования. Разли-
чают терминалы данных следующих типов – терминалы элементов управления и отображения данных, терминалы узлов.  

 
 Узлы – это объекты на блок-диаграмме, которые имеют одно или более полей ввода/вывода данных и выполняют 

алгоритмические операции ВП. Они аналогичны операторам, функциям и подпрограммам текстовых языков программиро-
вания. Узлы включают в себя функции, подпрограммы ВП и структуры. Подпрограмма ВП – виртуальный прибор, который 
можно использовать на блок-диаграмме другого ВП в качестве подпрограммы. Структуры – это элементы управления про-
цессом, такие как структура Case (Вариант), цикл While (цикл по условию) и т.д. Узлы Add (Сложение) и Subtract (Вычита-
ние) – узлы функций. 

Типы и проводники данных. В среде LabVIEW проводники данных используются для соединения многочисленных 
терминалов данных. Поля ввода/вывода должны быть совместимыми с типами данных, передаваемыми им по проводникам. 
Например, нельзя соединять поле вывода массива с полем ввода данных численного типа. Кроме того, характер соединения 
должен быть корректным. Проводники должны быть подсоединены лишь к одному источнику данных и, по крайней мере, к 



 

одному полю ввода данных. Например, нельзя соединять два элемента отображения. Компонентами, определяющими со-
вместимость соединения, являются: тип данных элемента управления и/или отображения и тип данных поля ввода/вывода. 

В данном курсе используются следующие типы данных: 
• Numeric (численный тип); 
• Floating point – число с плавающей запятой, отображается в виде оранжевых терминалов. Может быть представлено 

в виде single (32 bit), double (64-bit) или extended (128-bit) precision (с одиночной, двойной или расширенной точностью). 
Число с плавающей запятой может быть комплексным; 

• Integer – целочисленный тип, отображается в виде голубых терминалов. Возможны три представления целых чисел: 
8, 16 и 32 бита. Один бит может использоваться для знака числа, если это число является знаковым целым; 

• Boolean – логический тип, отображается в виде зеленых терминалов. Логический тип может принимать только два 
значения:  
0 (FALSE) или 1 (TRUE); 

• String – строковый тип, отображается в виде розовых терминалов. Строковый тип данных содержит текст в ASCII 
формате; 

• Path – путь к файлу, отображается в виде терминалов. Путь к файлу близок строковому типу, однако, LabVIEW 
форматирует его, используя стандартный синтаксис для используемой платформы; 

• Array – массивы включают типы данных составляющих элементов и принимают соответствующий им цвет; 
• Cluster – кластеры включают различные типы данных. Кластерный тип данных отображается коричневым цветом, 

если все его элементы численные, если же элементы кластера являются данными различных типов, он отображается розо-
вым; 

• Waveform – сигнальный тип данных является кластером элементов, содержащим данные, начальное значение вре-
мени и интервал времени между измерениями; 

• Dynamic – динамический тип, отображается в виде темно-синих терминалов. Кроме данных сигнала, динамический 
тип содержит дополнительную информацию, например, название сигнала или дату и время его получения. Большинство 
экспресс-ВП принимают и/или возвращают данные динамического типа. 

Данные между объектами блок-диаграммы передаются по соединительным линиям – проводникам данных. Проводник 
данных аналогичен переменным в текстовых языках программирования. Каждый проводник данных имеет единственный 
источник данных, но может передавать их ко многим ВП и функциям. Проводники данных различаются цветом, стилем и 
толщиной линии, в зависимости от типа передаваемых данных.  

Автоматическое соединение объектов проводниками данных.  
В среде LabVIEW объекты соединяются проводниками данных после их помещения на блок-диаграмму. В автоматиче-

ском режиме среда LabVIEW подключает те поля ввода/вывода данных, которые наиболее совместимы, несовместимые поля 
остаются несоединенными. 

Корректировка параметров автоматического подключения проводников осуществляется через пункты главного меню Tools 
→ Options →  Block Diagram. 

Соединение объектов проводниками данных вручную. Соединение объектов проводниками данных вручную произ-
водится с помощью инструмента СОЕДИНЕНИЕ. После наведения инструмента СОЕДИНЕНИЕ на поле ввода или вывода 
данных на экране появляется подсказка, которую можно использовать для уточнения места подключения проводника. 

 

З а д а н и е  2.1. Преобразование °С в °F 
 

Ниже приведена последовательность действий для создания ВП, который будет преобразовывать значение температуры 
из градусов Цельсия (°С) в температуру по Фаренгейту (°F). 

 

Лицевая панель 
 

1. Выберите пункт главного меню File → New → VI, чтобы открыть новую лицевую панель. 
2. Поместите цифровой элемент управления на лицевую панель. В поле собственной метки элемента управления напе-

чатайте «Град. С». 
3. Поместите элемент отображения данных на лицевую панель. Он будет использован для отображения значений тем-

пературы в °F. В поле собственной метки элемента управления напечатайте «Град. F» и щелкните мышью в свободном про-
странстве лицевой панели или нажмите кнопку Enter. 

 

 
 

На блок-диаграмме LabVIEW создаст терминалы данных, соответствующие элементам управления и отображения. 
Терминалы данных представляют тип данных соответствующих элементов. Например, терминал данных DBL представляет 
тип числовых данных двойной точности с плавающей запятой. 

 

Внимание! Терминалы данных, соответствующие элементам управления, имеют более широкий обводной контур по сравнению с 
терминалами данных, соответствующими элементам отображения. 

 

Блок-диаграмма 
 

4. Перейдите на блок-диаграмму, выбрав пункты главного меню Window → Show Diagram. 
5.   Создайте блок-диаграмму, показанную ниже: 



 

 

 

6. Выберите функцию Multiply (Умножение) из палитры Функций в разделе Functions → Numeric (Арифметические 
функции). Поместите ее на блок-диаграмму.  

7. Выберите функцию Add (Сложение) из палитры Функций в разделе Functions → Numeric (Арифметические функ-
ции). Поместите ее на блок-диаграмму. 

8. Выберите числовую константу из палитры Функций в разделе Functions → Numeric (Арифметические функции). 
Поместите две числовые константы на блок-диаграмму. После размещения числовой константы на блок-диаграмме поле 
ввода ее значений подсвечивается и готово для редактирования. Одной константе присвойте значение 1,8, другой 32,0. 

9. Соедините объекты блок-диаграммы с помощью инструмента СОЕДИНЕНИЕ. 
10.  Перейдите на лицевую панель, выбрав в главном меню пункт Window → Show Panel. 
11.  Сохраните ВП, он будет использоваться позднее.  
 

Запуск ВП 
 

1. Введите число в элемент управления и запустите ВП: 
а) для ввода числа в элемент управления следует использовать инструмент УПРАВЛЕНИЕ или инструмент ВВОД 

ТЕКСТА; 
б) нажмите кнопку Run, чтобы запустить ВП; 
в) введите несколько разных значений температуры и запустите ВП. 
2. Закройте ВП, выбрав пункт главного меню File → Close. 
 

З а д а н и е  2.2. Создать ВП согласно Вашему варианту 
 

№   
варианта Содержание задания 

1 
 

ВП преобразует значение температуры из градусов Цель-
сия в температуру по  шкале Кельвина (°К = °С + 273°) 

2 ВП преобразует значение температуры из градусов Цель-
сия в температуру по  шкале Реомюра (°R = °С ⋅ 4/5) 

3 ВП преобразует значение температуры по шкале Кельви-
на в градусы  Цельсия  (°С = ° К – 273°) 

4 ВП преобразует значение температуры по шкале Реомюра  
в градусы Цельсия  (°С = °R ⋅ 5/4) 

5 ВП преобразует значение температуры по Фаренгейту в 
градусы Цельсия (°F = 9/5 ⋅ °С + 32°) 

6 ВП преобразует значение температуры по шкале Реомюра 
в температуру по Фаренгейту  (°F = 9/4 ⋅ °R + 32°) 

7 ВП преобразует значение напряжения и силы тока по за-
кону Ома в сопротивление (R = U/I) 

8 ВП преобразует значение температуры по  Кельвину  в 
температуру по Реомюру  (°R = (°К – 273°) ⋅ 4/5) 

9 ВП преобразует по закону Ома  значение напряжения и 
сопротивления в силу тока (I = U/R) 

10 ВП преобразует значение динамической вязкости µ в ки-
нематическую ν  вязкость (ν = –µ/ρ) 

11 ВП  преобразует значения напряжения (мВ) и силы тока 
(мкА) в мощность (Вт)  (P = I ⋅ U) 

12 ВП преобразует значения напряжения (В) и силы тока  
(А) в мощность (Вт) (P = I ⋅ U) 

13 ВП преобразует значения массы (кг) и времени (с) в мас-
совый расход (кг/с) (G = m/t) 

14 ВП преобразует значения массы (кг) и объема  (м3) в 
плотность  (кг/м3)  (ρ = m/V) 



 

15 ВП преобразует значения объема (м3) и времени (с) в объ-
емный расход (м3/с)  (G = V/t) 

 
 

Контрольные вопросы 
 

1. Из каких основных компонентов состоит Ваш ВП? 
2. Какие узлы на блок-диаграмме ВП Вы знаете? 
3. Как отображаются терминалы данных и какие функции они выполняют? 
4. Что такое проводник данных? 
5. Какие проводники данных Вы знаете? 
6. Какие типы данных Вы знаете? 
7. Как соединяются объекты проводниками данных? 
8.  Из каких подпалитр состоит палитра Controls (Элементов)? 
9. Из каких подпалитр состоит палитра Functions (Функций)? 
10. Как осуществляется запуск разработанного ВП? 
11. Назовите назначение управляющих кнопок на блок-диаграмме. 
12. Назовите назначение управляющих кнопок на лицевой панели. 
13. Что такое элемент управления и элемент отображения? 
14. Назовите основные типы данных. 
15. Как ввести число в элемент управления?  

З а н я т и е  №  3  
 

СОЗДАНИЕ ПОДПРОГРАММ ВИРТУАЛЬНОГО ПРИБОРА 
 

Цель занятия: 
• изучить подпрограмму ВП; 
• создать иконку и настроить соединительную панель для возможности использования ВП в качестве подпрограммы 

ВП.  
 

ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 
 

Следующий шаг после создания блок-диаграммы и формирования лицевой панели ВП – создание иконки ВП и на-
стройка соединительной панели для использования виртуального прибора в качестве подпрограммы ВП. Подпрограмма ВП 
соответствует подпрограмме в текстовых языках программирования. Использование подпрограмм ВП помогает быстро 
управлять изменениями и отладкой блок-диаграмм.  

Любой ВП может быть использован как подпрограмма при создании в последующем других виртуальных инструмен-
тов. Для объединения нескольких функциональных блоков разрабатываемой блок-диаграммы в подпрограмму достаточно 
выделить их мышкой на диаграмме, удерживая клавишу Shift, и затем выбрать в верхнем меню пункт Edit – Create SubVI. 
При этом они объединятся в новую подпрограмму с новым значком (иконкой) на функциональной панели. Двойной клик на 
данном значке позволит вызвать созданную подпрограмму, настроить ее должным образом и сохранить с заданным именем. 
В последующем данный модуль может быть многократно использован в различных ВП. 

Каждый виртуальный прибор в правом верхнем углу лицевой панели и в окне блок-диаграммы отображает иконку 

. Иконка – графическое представление прибора. Она может содержать текст, рисунок или и то и другое одновременно. Если 
ВП используется в качестве подпрограммы, то иконка идентифицирует его на блок-диаграмме другого ВП. 

Для редактирования иконки создаваемых ВП и подпрограмм достаточно кликнуть правой кнопкой мыши на пикто-
грамме ВП в правом верхнем углу и выбрать пункт Edit Icon … (рис. 3.1). 

С помощью простейших функций графического редактора можно создать собственный вариант иконки. Настройка вхо-
дов/выходов (терминалов) подпрограмм осуществляется следующим образом. Необходимо нажать правой кнопкой мыши на 
пиктограмме vi в правом верхнем углу и выбрать пункт Show Connector… (рис. 3.2). При этом пиктограмма разделится на 
несколько прямоугольников, общий набор и вид которых можно редактировать с помощью всплывающего меню пиктограм-
мы (добавить/удалить терминал – Add Terminal/Remove Terminal,  

 



 

 
 

Рис 3.1. Выбор пункта Edit Icon 
 

 
 

Рис 3.2. Выбор пункта Show Connector 
 

поворот на 90 градусов – Rotate 90 Degrees, другой вид – Patterns… и др.). Для того, что бы сопоставить каждый терминал с 
определенными данными, необходимо левой кнопкой мыши кликнуть на нужном терминале, а затем – на том элементе 
управления или отображения на лицевой панели, которой он будет соответствовать. При этом терминал окрасится в цвет, 
соответствующий типу данных указанного элемента управления или отображения. В результате все терминалы будут связа-
ны с определенными входными или выходными данными. 

Использование подпрограмм ВП. После создания ВП, оформления его иконки и настройки соединительной панели 
ВП может использоваться в качестве подпрограммы. Чтобы поместить подпрограмму ВП на блок-диаграмму, следует вы-
брать на палитре Functions (Функций) подраздел Select a VI (Выбор ВП), указать ВП и перенести его на блок-диаграмму. 

Открытый ВП можно поместить на блок-диаграмму другого ВП, переместив на нее иконку этого ВП с помощью инст-
румента ПЕРЕМЕЩЕНИЕ. 

 

З а д а н и е  3.1.  ВП Преобразования °С в °F 
 

Ниже представлена последовательность действий по созданию иконки и настройке соединительной панели для соз-
данного ВП, который переводит значение измеренной температуры из градусов Цельсия в градусы по Фаренгейту. 

 

Лицевая панель 
 

1. Откройте файл с ранее созданным ВП Преобразование С в F (начало).vi. 
 

Иконка и соединительная панель 
 

2. Щелкните правой кнопкой мыши по иконке ВП и в контекстном меню выберите пункт Edit Icon (Редактирование 
иконки). Появится диалоговое окно редактора иконки Icon Editor. 

3. Дважды щелкните правой кнопкой мыши по инструменту ВЫБОР . 
4. Нажав кнопку <Delete>, очистите область редактирования иконки. 

5. Дважды щелкните по инструменту ПРЯМОУГОЛЬНИК , чтобы обвести область редактирования границей вы-
бранного цвета. 

6. Создайте следующую иконку: 
 



 

 

а) введите текст инструментом ВВОД ТЕКСТА  ; 
б) напечатайте «С» и «F»; 
в) для выбора размера шрифта дважды щелкните левой кнопкой мыши по инструменту ВВОД ТЕКСТА; 

г) чтобы нарисовать стрелку, воспользуйтесь инструментом КАРАНДАШ  ; 
 

Внимание! Для рисования вертикальных, горизонтальных и диагональных линий требуется во время рисования нажать и удерживать 
клавишу <Shift>. 

 

д) для передвижения текста и стрелки по полю редактирования иконки используйте инстру-
мент ВЫБОР и стрелки на клавиатуре; 

е) в разделе Copy from (Копировать из) выберите В & W (черно-белую) иконку и 256 Colors (256-цветный режим) для 
создания черно-белой иконки, которую LabVIEW использует в случае отсутствия цветного принтера; 

ж) в разделе Copy from (Копировать из) выберите 16 Colors и 256 Colors; 
з) после завершения редактирования иконки нажмите кнопку ОК и закройте Icon Editor. Новая иконка появится в пра-

вом верхнем углу обеих панелей. 
7. Перейдите на лицевую панель, щелкните правой кнопкой мыши на иконке и выберите пункт Show Connector (Пока-

зать поля ввода/вывода данных) из контекстного меню. Количество отображаемых LabVIEW полей ввода/вывода данных 
соответствует количеству элементов на лицевой панели. Например, лицевая панель этого ВП имеет два элемента Град С и 
Град F, и LabVIEW выводит в соединительной панели два поля. 

8. Элементам управления и отображения данных назначьте соответственно поля ввода и вывода данных: 
а) в пункте главного меню Help (Помощь) выберите Show Context Help (показать контекстную справку) и выведите на 

экран окно Context Help (контекстной справки) для просмотра соединений; 
б) щелкните левой кнопкой мышки на левом поле соединительной панели. Инструмент УПРАВЛЕНИЕ автоматически 

поменяется на инструмент СОЕДИНЕНИЕ, а выбранное поле окрасится в черный цвет; 
в) щелкните левой кнопкой мыши по элементу Град С. Левое поле станет оранжевым и выделится маркером; 
г) щелкните курсором по свободному пространству. Маркер исчезнет, и поле окрасится в цвет данных типа соответст-

вующего элемента управления; 
д) щелкните левой кнопкой мыши по правому полю соединительной панели и элементу Град. F. Правое поле станет 

оранжевым; 
е) щелкните курсором по свободному пространству. Оба поля останутся оранжевыми; 
ж) наведите курсор на область полей ввода/вывода данных. Окно Context Help (контекстной справки) покажет, что оба 

поля соответствуют типу данных двойной точности с плавающей запятой. 
9. Выберите пункт главного меню File → Save. Сохраните ВП под именем Преобразование С в F.vi. 
10. Выберите пункт главного меню File → Close. Закройте ВП. 
 

З а д а н и е  3.2. ВП Термометр  
 

Ниже приведена последовательность действий для создания ВП, который измеряет температуру и отображает значение 
температуры в градусах Цельсия или температуру по Фаренгейту. 

 

Лицевая панель 
 

1. Создайте элемент отображения данных температуры, как показано ниже: 
 
 
 
 
 
 
 
 

а) выберите элемент отображения данных, расположенный на палитре Controls в разделе Numeric (Числовые элементы) 
; 

б) напечатайте «Температура» внутри собственной метки и нажмите кнопку Enter на инструментальной панели ; 
в) щелкните правой кнопкой мыши по элементу и выберите пункт контекстного меню Visible Items (Отображаемые 

элементы), Digital Display (Цифровой индикатор) . 



 

2. Создайте элемент управления в виде вертикального переключателя : 
а) выберите вертикальный переключатель, расположенный в палитре Controls раздела Boolean (Логические элементы) 

; 
б) введите имя собственной метки переключателя Масштаб шкалы и нажмите кнопку Enter на инструментальной пане-

ли; 
в) используя инструмент ВВОД ТЕКСТА, создайте на лицевой панели свободную метку °С, как показано выше; 
г) с помощью инструмента ВВОД ТЕКСТА создайте на лицевой панели свободную метку °F, как показано выше. 
3. Создайте описание ВП, которое появляется в окне контекстной справки Context Help после наведения курсора на 

иконку ВП: 
a) выберите пункт главного меню File → VI Properties; 
б) выберите пункт Documentation (Описание) в разделе Category (Категория) из выпадающего меню; 
в) в поле ввода текста напечатайте следующее: 
Этот ВП измеряет температуру, используя ВП Demo Read Voltage VI. 
4. Создайте описание элементов управления и отображения данных, которое появляется в окне контекстной справки 

Context Help после наведения на них курсора: 
a) щелкните правой кнопкой мыши по элементу отображения и выберите пункт контекстного меню Description and Tip 

(Описание и предупреждения); 
б) в поле ввода текста напечатайте следующее: 
Выводит на экран значения измеренной температуры; 
в) введите в поле Tip значение Температура; 
г) нажмите кнопку ОК; 
д) щелкните правой кнопкой мыши по элементу управления и выберите пункт контекстного меню Description and Tip 

(Описание и предупреждения); 
е) в поле ввода текста напечатайте следующее: 
Определяет шкалу (по Фаренгейту или Цельсию), используемую для измерения температуры; 

ж) введите в поле Tip значение шкала – °С или °F и нажмите кнопку ОК. 
5. Отобразите окно контекстной справки Context Help, которое доступно из пункта главного меню Help → Show Con-

text Help. 
6. Наведите курсор на один из объектов для просмотра описания их работы в окне Context Help. 
 

Блок-диаграмма 
 

7. Перейдите на блок-диаграмму, выбрав Window → Show Diagram. 
8. Создайте блок-диаграмму, показанную ниже. 

 

 
 Поместите на блок-диаграмму ВП Demo Read Voltage VI, расположенный в каталоге I:\Texts\AICiI\for_LabVIEW, 

который служит для имитации считывания напряжения, пропорционального температуре. Например, если температура со-
ставляет 20 °С, то напряжение на выходе датчика будет равно 20 В.  

  Поместите на блок-диаграмму ВП Convert from Dynamic Data (преобразовать динамические данные), располо-
женный в палитре Functions → Express → Signal Manipulation. Этот ВП преобразует динамический тип данных. В конфигу-
рационном диалоговом окне выберите пункт Single Scalar in списка Resulting data type. 

  Выберите функцию Multiply (Умножение), расположенную в палитре Functions → Numeric. Эта функция умножает 
считанное ВП Read Voltage VI напряжение на 100.0 для представления температуры в градусах Цельсия; 

  Щелкните правой кнопкой мыши по полю ввода данных у функции Multiply (Умножение) и в контекстном меню 
выберите пункт Create → Constant (Создать константу). Константе присвойте значение «100» и нажмите клавишу <Enter>. 

  В палитре Functions (Функций) в разделе Select a VI (Выбор ВП) выберите ВП Преобразование °С в °F, создан-
ный в задании 3.1. Поместите его на блок-диаграмму. Этот ВП переведет градусы Цельсия в градусы Фаренгейта. 

  Выберите функцию Select (Выбор), расположенную в палитре Functions → Comparison. Эта функция выдает зна-
чения °С или °F в зависимости от состояния переключателя Масштаб шкалы. 

 
 

Лицевая панель 
 

9. Перейдите на лицевую панель. 
10. Нажмите на кнопку непрерывного запуска, показанную слева. 
11. Нажмите на кнопку непрерывного запуска еще раз для остановки ВП. 



 

 
 

Иконка и соединительная панель 
 

12. Создайте иконку, показанную ниже, чтобы использовать ВП в качестве подпрограммы. 

 
 

13. Элементам управления и отображения данных поставьте в соответствие поля ввода и вывода данных, щелкнув пра-
вой кнопкой мыши по иконке и выбрав пункт контекстного меню Show Connector (Показать поля ввода/вывода данных). 

14. Сохраните ВП под именем Термометр, он будет использоваться позднее. 
15. Закройте ВП, выбрав пункт главного меню File → Close. 
 
З а д а н и е  3.3. Аналогично заданию 3.2 создать ВП, используя в качестве подпрограммы прибор, созданный в 

задании 2.2  
 

№   
варианта Содержание задания 

1 ВП измеряет температуру и отображает значение темпе-
ратуры по шкале Кельвина или в градусах Цельсия 

2 ВП измеряет температуру и отображает значение темпе-
ратуры по шкале  Реомюра или в градусах Цельсия        

3 ВП измеряет температуру и отображает значение темпе-
ратуры в градусах Цельсия или по шкале Кельвина  

4 ВП измеряет температуру и отображает значение темпе-
ратуры в градусах Цельсия или по шкале  Реомюра             

5 ВП измеряет температуру и отображает значение темпе-
ратуры в градусах Цельсия или по шкале  Фаренгейта        

6 ВП измеряет температуру и отображает значение темпе-
ратуры по Реомюру или по шкале Фаренгейта                  

7 ВП измеряет напряжение; на выходе – значение напря-
жения или сопротивления (рассчитанного по закону 
Ома) в зависимости от состояния переключателя 

8 ВП измеряет температуру и отображает значение темпе-
ратуры по Кельвину или по шкале  Реомюра                  

9 ВП измеряет напряжение; на выходе – значение напря-
жения или силы тока (рассчитанной по закону Ома) в 
зависимости от состояния переключателя  

10 ВП измеряет вязкость и отображает значение динамиче-
ской µ или кинематической  вязкости ν 

11 ВП измеряет напряжение и силу тока и отображает  на-
пряжения (мВ) или мощность (Вт) 

12 ВП измеряет напряжение и силу тока и отображает на-
пряжение (В) или мощность (Вт) 

13 ВП измеряет значения массы и объема и отображает 
массу (кг) или расход (кг/с) 

14 ВП измеряет объем и массу и отображает объем (м3) или 
плотность (кг/м3) 

15 ВП измеряет объем и время и отображает значение объ-
ема (м3) или объемного расхода (м3/с) 



 

Примечания: 1) Для имитации считывания напряжения, пропорцио-
нального температуре в вариантах № 1 – 9, 11, 12, следует использовать ВП 
Demo Read Voltage VI, расположенный в каталоге i:\Text\AICI\for_LabVIEW;  
2) в вариантах № 10, 13 – 15 для имитации считывания значений вязкости, 
массы, объема, времени и силы тока – функцию Random Number (0-1), распо-
ложенную в палитре Functions → Numeric. Эта функция будет генерировать 
случайные числа в пределах от 0 до 1.  

 
 
 
 
 
 

Контрольные вопросы 
 

 

1. Из каких основных компонентов состоит Ваш ВП? 
2. Что называется иконкой ВП? 
3. Как создать иконку ВП? 
4. Что такое соединительная панель ВП? 
5. Как настроить соединительную панель ВП? 
6. Как редактируется иконка ВП? 
7. Как поместить подпрограмму ВП на блок-диаграмму? 
8. Зачем нужна функция Select? 
9. Как осуществляется непрерывный пуск ВП? 
10. Поясните назначение каждого инструмента, используемого для редактирования иконки в Icon Editor (Редакторе 

иконки). 
 
Занятие  № 4 
 

МНОГОКРАТНЫЕ ПОВТОРЕНИЯ И ЦИКЛЫ ПРИ СОЗДАНИИ ВИРТУАЛЬНОГО ПРИБОРА В СРЕДЕ LabVIEW 
 

Цель занятия: 
• изучение основных структур среды LabView; 
• измерение температуры с интервалом 1 секунда в течение одной минуты; 
• использование сдвиговых регистров и узлов обратной связи для организации доступа к значениям на предыдущих 

итерациях цикла For (с фиксированным числом итераций); 
• изучение организации доступа к значениям предыдущих итераций цикла. 

 

ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 
 

Структуры являются графическим представлением операторов цикла и операторов Case (Варианта), используемых в 
текстовых языках программирования. Структуры на блок-диаграмме используются для выполнения повторяющихся опера-
ций над потоком данных, операций в определенном порядке и наложения условий на выполнение операций. Среда LabVIEW 
содержит пять структур: Цикл While (по условию), Цикл For (с фиксированным числом итераций), структура Case (Вариант), 
структура Sequence (‘сиквенс) (Последовательность), структура Event (Событие), а также Formula Node (узел Формулы). 

Цикл While (по условию).  Цикл While (по условию) работает до тех пор, пока не выполнится логическое условие вы-
хода из цикла. 

 Блок-диаграмма цикла While выполняется до тех пор, пока не выполнится условие выхода из цикла. По умолчанию 
терминал условия выхода имеет вид, показанный слева. Это значит, что цикл будет выполняться до поступления на терми-
нал условия выхода значения TRUE. В этом случае терминал условия выхода называется терминалом Stop If True (Остановка 
если Истина). 

 Терминал счетчика итераций, показанный слева, содержит значение количества выполненных итераций. Начальное 
значение терминала всегда равно нулю. 

 Предусмотрена возможность изменения условия выхода и соответствующего ему изображения терминала условия 
выхода. Щелчком правой кнопки мыши по терминалу условия выхода или по границе цикла необходимо вызвать контекст-
ное меню и выбрать пункт Continue If True (Продолжение если Истина). 

Цикл For (с фиксированным числом итераций). Цикл For (с фиксированным числом итераций) выполняет повто-
ряющиеся операции над потоком данных определенное количество раз. 

 Цикл For расположен в палитре Функций в разделе Functions → → Structures. Значение, присвоенное терминалу мак-
симального числа итераций N цикла, показанного слева, определяет максимальное количество повторений операций над по-
током данных. 

 Терминал счетчика итераций, показанный слева, содержит значение количества выполненных итераций. Начальное 
значение счетчика итераций всегда равно 0. 



 

Организация доступа к значениям предыдущих итераций цикла. При работе с циклами зачастую необходим 
доступ к значениям предыдущих итераций цикла. Например, в случае ВП, измеряющего температуру и отобра-
жающего ее на графике, для отображения текущего среднего значения температуры необходимо использовать 
значения, полученные в предыдущих итерациях. Есть два пути доступа к этим данным: Shift Register (сдвиговый 
регистр) и Feedback Node (узел обратной связи). 

Сдвиговые регистры. Сдвиговые регистры используются при работе с циклами для передачи значений от те-
кущей итерации цикла к следующей. Сдвиговые регистры аналогичны статическим переменным в текстовых язы-
ках программирования 

Сдвиговый регистр выглядит как пара терминалов, показанных слева. Они расположены непосредственно 
друг против друга на противоположных вертикальных сторонах границы цикла. Правый терминал содержит стрелку «вверх» 
и сохраняет данные по завершению текущей итерации. LabVIEW передает данные с этого регистра в следующую итерацию 
цикла. Сдвиговый регистр создается щелчком правой кнопки мыши по границе цикла и выбором из контекстного меню 
пункта Add Shift Register (Добавить сдвиговый регистр). 

Чтобы инициализировать сдвиговый регистр, необходимо передать на его левый терминал любое значение извне цикла. 
Если не инициализировать сдвиговый регистр, он использует значение, записанное в регистр во время последнего выполне-
ния цикла или значение, используемое по умолчанию для данного типа данных, если цикл никогда не выполнялся.  

Предусмотрена возможность создания нескольких сдвиговых регистров в одной структуре цикла. Если в одном цикле 
выполняется несколько операций, следует использовать сдвиговый регистр с несколькими терминалами для хранения дан-
ных, полученных в результате выполнения различных операций цикла. На рис. 4.1 показано использование двух инициали-
зированных сдвиговых регистров. 

 
Рис. 4.1. Использование сдвиговых регистров в цикле For 

 

Узлы обратной связи. Узел обратной связи, показанный слева, автоматически появляется в циклах While 
или For при соединении поля вывода данных подпрограммы ВП, функции или группы подпрограмм ВП и функций с полем 
ввода данных тех же самых подпрограмм ВП, функций или их групп. Как и сдвиговый регистр, узел обратной связи сохра-
няет данные любого типа по завершению текущей итерации и передает эти значения в следующую итерацию. Использова-
ние узлов обратной связи позволяет избежать большого количества проводников данных и соединений. 

Можно поместить узел обратной связи внутри цикла While или For, выбрав Feedback Node (Узел обратной связи) в па-
литре Structures (Структуры). При помещении узла обратной связи на проводник данных до ответвления, передающего дан-
ные на выходной терминал цикла, узел обратной связи передает все значения на выходной терминал цикла. При помещении 
узла обратной связи на проводник после ответвления, передающего данные на выходной терминал цикла, узел обратной свя-
зи передаст все значения обратно на поле ввода данных ВП или функции, а затем передаст последнее значение на выходной 
терминал цикла.  

Структура выбора Case. В структуре выбора Case имеются две или более встроенных блок-схемы. Выбор одной из 
них определяется в зависимости от значения, поданного на вход данной структуры. Структура Case включает:  

• Терминал выбора ?. Значение, подаваемое на него, может быть целочисленным, логическим или строковым.  
• Переключатель блок-схем (True \ False \ и т.д.). Позволяет переходить от одной блок-схемы к другой. Содержит по умол-

чанию два окна True и False. При необходимости количество блок-схем выбора может быть увеличено. Кроме True и False, в каче-
стве значений переключателя могут использоваться целые числа или строковые значения. 

В качестве примера использования структуры Case вместо функции Select приведена измененная блок-диаграмма ВП Термо-
метр (рис. 4.2). На переднем плане структуры Case показан логический вариант TRUE (рис. 4.2, а). 

 
а) 

 
б) 



 

 
в) 

 

Рис. 4.2. Применение структуры Case в ВП Термометр:  
а – логический вариант TRUE; б – выбор варианта;  

в – логический вариант FALSE 
 

Определение варианта осуществляется либо выбором значения на селекторе структуры Case, либо вводом значения с 
помощью инструмента ВВОД ТЕКСТА (рис. 4.2, б). 

Выбранный вариант появляется на переднем плане, как показано на блок-диаграмме (рис. 4.2, в).    

Значения селектора варианта должны быть того же типа, что и тип данных, подаваемых на терминал селектора вариан-
та. Значение селектора варианта, окрашенное красным цветом, показывает, что его необходимо удалить или отредактиро-
вать, иначе ВП не будет выполняться. Нельзя подавать числа с плавающей точкой на терминал селектора варианта, так как 
возможны ошибки округления и возникновение ситуации неопределенности. Если подать число с плавающей точкой на тер-
минал селектора варианта, LabVIEW округлит это значение до ближайшего четного целого. Если число с плавающей точкой 
введено непосредственно в селектор варианта, то оно окрашивается в красный цвет и должно быть удалено или отредакти-
ровано. 

Формульный блок Formula Node. Формульный блок Formula Node позволяет вводить формулы в обычном виде прямо 
в блок-схему. Особенно это удобно, когда выражение имеет много переменных и сложный вид. Формулы вводятся как про-
стой текст. При этом создаются терминалы на границе блока (контекстное меню Add Input или Add Output), куда вписыва-
ются имена переменных. Каждое выражение заканчивается разделителем «;».  

Узел Формулы может также использоваться для принятия решений. На следующей блок-диаграмме показан способ 
применения операторов if- then в узле Формулы. 

 
 

Последовательная структура Sequence Structure. Последовательная структура Sequence Structure выполняет встроен-
ные в нее блок-схемы последовательно в определенном порядке. Количество встроенных блок-схем определяется числом 
фреймов данной структуры. Их количество увеличивается при помощи контекстного меню – Add Frame After, Add Frame 
Before. Для передачи значений переменных из фрейма в фрейм используются локальные переменные структуры (контекст-
ное меню – Add Sequence Local variable), создаваемые на границе фрейма. Данные, связанные с такой переменной, доступны 
во всех последующих фреймах и не доступны в предыдущих. 

 

Задание  4.1.  ВП Измерение температуры во времени 
 

Ниже приведена последовательность действий для создания ВП, который использует ВП «Термометр» для измерения 
температуры 1 раз в секунду в течение одной минуты. 

 

Лицевая панель 
 

1. Откройте новый ВП и создайте лицевую панель, как показано ниже на рисунке: 

 
Поместите Термометр, расположенный на палитре Controls → → Numeric, на блок-диаграмму для отображения на эк-

ране измерений температуры. 
Поместите на лицевую панель цифровой элемент отображения данных, расположенный в палитре ControIs → Numeric. 

Назовите его Секунды. 
 

Блок-диаграмма 
 

2. Создайте блок-диаграмму, показанную ниже. 
 



 

 

 Поместите ВП Термометр на блок-диаграмму. Для этого выберите Functions → Select a VI и укажите папку, в ко-
торой находится прибор, созданный в задании 3.2. 

Щелкните правой кнопкой мыши по полю ввода данных Temp Scale (Шкала температур), в контекстном меню выберите 
пункт Create → → Constant. Константе присвойте значение FALSE – для градусов Фаренгейта и TRUE – для градусов Цель-
сия. 

Поместите на блок-диаграмму функцию Wait Until Next ms Multiple, находящуюся в палитре Functions → Time and Dia-
log. Функция Wait Until Next ms Multiple (ждать кратного значения), показанная слева, обеспечивает интервал между итера-
циями, равный интервалу времени, необходимому для того, чтобы миллисекундный счетчик достиг значения, кратного вве-
денному пользователем. Щелкните правой кнопкой мыши по полю ввода данных и выберите пункт Create → Constant. Соз-
данной константе присвойте значение 1000. Теперь каждая итерация цикла выполняется с интервалом времени 1000 мс (раз 
в секунду). 

Поместите на блок-диаграмму функцию Increment (приращение), находящуюся в палитре Functions → Numeric. Эта 
функция добавляет 1 к значению счетчика итераций после завершения выполнения цикла. 

3. Сохраните ВП под именем Измерение температуры во времени. 
4. Запустите ВП.  
5. Закройте ВП. 
Задание  4.2. Создать ВП, согласно Вашему варианту 
 

№ 
варианта Содержание задания 

1 Создайте ВП, генерирующий случайные числа в цикле 
While. Организуйте выход из цикла по нажатию кнопки 
на лицевой панели ВП 

2 Посчитайте значение выражения Y = X 
2 + Z 

3 – XZ + 10 с 
помощью блока Formula Node и ВП Formula Express, 
расположенных в палитре Functions → Arith/Compare 
(арифметика/сравнение) 

3 Создайте ВП, который с помощью Formula Node  считает 
значение выражения y = sin (x), если у – положительное 
число,  то z = y + A,  иначе z = y – A 

4 Создайте ВП, который с помощью Formula Node  считает 
значение выражения Y = x + cos (x) – 10, и  если Y >= 0, то 
Z = sqrt(Y) 

5 
 

Используя  структуру Сase, создайте ВП, который счита-
ет разность 2-х чисел, и если полученное число 0≥ , то 
вычисляется значение корня, иначе выдается сообщение 
об ошибке 

6 
 

ВП осуществляет поочередное включение индикаторов 
на лицевой панели; промежутки между включениями 
индикаторов 2, 3 и 7 с, соответственно. Используйте по-
следовательность Sequence Structure и функцию Time 
Delay, расположенную в палитре Functions → Time and 
Dialog 

7 
 

Создайте ВП, который измеряет температуру в течение 
минуты с помощью термометра, созданного в задании 3.2,  
и считает среднее значение температуры. Подсчет сред-
него значения осуществить с помощью сдвигового реги-
стра 

8 
 

Посчитайте значение выражения Y = X 
5 + cos2(Z) – XZ + 10 с 

помощью блока Formula Node и ВП Formula Express, 
расположенных в палитре Functions → Arith/Compare 
(арифметика/сравнение) 



 

9 
 

Используя  структуру Сase, создайте ВП, который счита-
ет значение выражения y = ax + 14, где a = const,  и если  
y 0≥ , то вычисляется значение корня, иначе выдается 
сообщение об ошибке 

10 
 

Создайте ВП, который генерирует 70 случайных чисел и 
считает среднее значение. Подсчет среднего значения 
осуществите с помощью сдвигового регистра 

11 Создайте ВП, генерирующий 70 случайных чисел в цик-
ле FOR 

 
12 

ВП осуществляет поочередное включение индикаторов 
на лицевой панели; промежутки между включениями 
индикаторов 5, 8 и 12 с, соответственно. Используйте 
последовательность Sequence Structure и функцию Time 
Delay, расположенную в палитре Functions → Time and 
Dialog 

13 Посчитайте значение выражения Y = 10X 
5 + sin2(Z) – XZV 

с помощью блока Formula Node и ВП Formula Express, 
расположенных в палитре Functions → Arith/Compare 
(арифметика/сравнение) 

14 Создайте ВП, генерирующий случайные числа в цикле 
While. Организуйте выход из цикла по нажатию кнопки 
на лицевой панели ВП 

15 Создайте ВП, который генерирует случайные числа до 
тех пор, пока одно из них не окажется равным значению, 
введенному в элемент управления 

 

Контрольные вопросы 
 

1. Из каких основных компонентов состоит Ваш ВП? 
2. Для чего предназначена структура последовательности Sequence Structurе? Как добавить фрейм в Sequence 

Structurе? 
3. Какие приемы использования цикла While Вы знаете? 
4. Как измерить температуру с интервалом 30 с в течение 2 мин? 
5. Как и зачем используются сдвиговые регистры в ВП? 
6. Зачем нужны узлы обратной связи? 
7. Как добавить 1 к значению счетчика итераций после завершения выполнения цикла? 
8. Для чего предназначена структура выбора Case? Какие типы данных можно подавать на терминал выбора структу-

ры Case? 
9. Для чего предназначен формульный блок Formula Node? Как создать терминал на границе блока Formula Node? 
10. Назовите назначение терминалов в цикле For. 

Занятие  № 5 
 

РАБОТА С МАССИВАМИ В СРЕДЕ LabVIEW 
 

Цель занятия:  
• изучить типовые приемы создания массива элементов управления и отображения; 
•  изучить типовые приемы создания массива констант;  
• изучить функции работы с массивами; 
• освоить приемы работы с массивами. 
 

ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 
 

Массивы объединяют элементы одного типа данных. Массив – это набор элементов определенной размерности. Эле-
ментами массива называют группу составляющих его объектов. Размерность массива – это совокупность столбцов (длина) и 
строк (высота), а также глубина массива. Массив может иметь одну и более размерностей в каждом направлении, насколько 
позволяет оперативная память. 

Данные, составляющие массив, могут быть любого типа: целочисленного, логического или строкового. Массив также 
может содержать элементы графического представления данных и кластеры. Использовать массивы удобно при работе с 
группами данных одного типа и при накоплении данных после повторяющихся вычислений. Массивы идеально подходят 
для хранения данных, полученных с графиков, или накопленных во время работы циклов, причем одна итерация цикла соз-
дает один элемент массива. 

Все элементы массива упорядочены. Чтобы к ним было легко обращаться, каждому элементу присвоен индекс. Нуме-
рация элементов массива всегда начинается с 0. Таким образом, индексы массива находятся в диапазоне от 0 до (n – 1), где n 
– число элементов в массиве. 



 

Создание массива элементов управления и отображения. Для создания массива элементов управления или отобра-
жения данных, как показано в примере, необходимо выбрать шаблон массива из палитры Controls → Array & Cluster и по-
местить его на лицевую панель. Затем поместить в шаблон массива элемент управления либо отображения данных.  

 
Создание массива констант. Создать массив констант на блок-диаграмме можно, выбрав в палитре Functions → 

Array шаблон Array Constant и поместив в него числовую константу. Массив констант удобно использовать для передачи 
данных в подпрограммы ВП. 

Двумерные массивы. В двумерном (2D) массиве элементы хранятся в виде матрицы. Таким образом, для размещения 
элемента требуется указание индекса столбца и строки. Ниже показан двумерный массив, состоящий из 6 столбцов (длина) и 
4 строк (высота). Количество элементов в массиве – 24 (6 × 4 = 24). 

 

 
 

Для увеличения размерности массива необходимо щелкнуть правой кнопкой мыши по элементу индекса и выбрать из 
контекстного меню пункт Add Dimension (Добавить размер). С этой целью также можно использовать инструмент ПЕРЕ-
МЕЩЕНИЕ. Для этого надо просто изменить размер элемента индекса.  

Автоматическая индексация. Цикл For и цикл While могут автоматически накапливать массивы и проводить их ин-
дексацию на своих границах. Это свойство называется автоиндексацией. После соединения терминала данных массива с 
терминалом выхода из цикла каждая итерация цикла создает новый элемент массива. На экране видно, что проводник дан-
ных, соединяющий терминал данных массива с терминалом выхода из цикла, стал толще, а сам терминал выхода из цикла 
окрашен в цвет терминала данных массива. 

 

 
Автоиндексация отключается щелчком правой кнопки мыши по терминалу входа/выхода из цикла и выбором пункта 

контекстного меню Disable Indexing (запретить автоиндексацию). Автоиндексацию следует отключать, например, в случае, 
когда нужно знать только последнее значение. 

Ввиду того, что цикл For часто используется при работе с циклами, для него в LabVIEW автоиндексация включена по 
умолчанию. Для цикла While автоиндексация по умолчанию отключена. Для того, чтобы включить автоиндексацию, необхо-
димо щелкнуть правой кнопкой мыши по терминалу входа/выхода из цикла и выбрать в контекстном меню пункт Enable 
Indexing (разрешить автоиндексацию). 

Создание двумерных (2D) массивов. Для создания двумерных массивов необходимо использовать два цикла For, один 
внутри другого. Как показано на иллюстрации, внешний цикл создает элементы массива в строке, а внутренний цикл создает 
элементы массива в столбце. 

 



 

Функции работы с массивами. Для создания и управления массивами используются функции, расположенные в па-
литре Functions → → Array. Наиболее часто используемые функции работы с массивами включают в себя: 

 Array Size (Размер массива) – показывает количество элементов массива каждой размерности. Если массив n-
мерный, на выходе функции Array Size будет массив из n элементов.  

Например, для приведенного ниже массива функция Array Size выдаст значение 3. 

 

 Initialize Array (задать массив) – создает n-мерный массив, в котором каждый элемент инициализирован значени-
ем поля ввода данных element. Для увеличения размерности массива достаточно добавить поля ввода данных, растянув узел 
функции. Например, если для функции Initialize Array заданы следующие значения параметров: на поле element подается 
значение 4, а на поле dimension size (если оно одно) – значение 3, то на выходе получится массив, показанный ниже. 

 

 Build Array (создать массив) – объединяет несколько массивов или добавляет элемент в n-мерный массив. Изме-
нение размера функции увеличивает количество полей ввода данных, что позволяет увеличить количество добавляемых 
элементов. Например, если объединить два предыдущих массива, то функция Build Array выдаст на выходе следующий мас-
сив: 

 

 
 

Для объединения входных данных в более длинный массив той же размерности, как показано ниже, достаточно щелк-
нуть правой кнопкой мыши на функции и выбрать из контекстного меню пункт Concatenate Inputs (объединение входных 
данных). 

 

 
 

 Array Subset (подмножество массива) – выдает часть массива, начиная с индекса, поступившего на поле index, и 
длиной, указанной в поле length (длина). Например, если подать предыдущий массив на поле ввода функции Array Subset, 
значение 2 – на поле index и 3 – на поле Подмножество: 

 

 
 

 Index Array (индекс массива) – выдает элемент, соответствующий индексу, значение которого подается на поле 
ввода index. Например, при использовании предыдущего массива функция Index Array выдаст значение 2, если на поле ввода 
данных index подать значение 0. 

Функцию Index Array можно использовать для выделения строки или столбца из двумерного массива и дальнейшего 
отображения в виде подмассива. Для этого двумерный массив надо подать в поле ввода данных функции. Функция Index 
Array должна иметь два поля index. Верхнее поле index указывает строку, а нижнее – столбец. Можно задействовать оба поля 
index для выбора отдельного элемента или только одно, для выбора строки или столбца. Например, в поле ввода данных 
функции подается массив, показанный ниже: 

 

 
 

Функция Index Array в поле вывода данных выдаст следующий массив в случае, если на поле index (строка) подается 
значение 0: 

 

 
 
 
 



 

Задание  5.1. ВП Работа с массивами 
 

Выполните следующие шаги для создания ВП, который формирует массив случайных чисел, масштабирует получен-
ный массив и выделяет из него подмножество. 

 

Лицевая панель 
 

1. Откройте новый ВП и создайте лицевую панель, как показано ниже: 
а) в палитре ControIs → Array & Cluster выберите шаблон массива; 
б) созданному массиву присвойте имя Массив случайных чисел; 
в) поместите внутрь шаблона массива цифровой элемент отображения, расположенный в палитре Controls → Numeric; 
г) с помощью инструмента ПЕРЕМЕЩЕНИЕ измените размер массива таким образом, чтобы он содержал 10 элемен-

тов; 
д) нажмите и удерживайте клавишу <CtrI> и, перемещая элемент Массив случайных чисел, создать две его копии; 
е) копиям присвойте имена Конечный массив и Подмножество массива; 
ж) создайте три цифровых элемента управления и присвойте им имена Масштабный коэффициент, Старт подмноже-

ства, Количество элементов подмножества; 
з) щелкните правой кнопкой мыши по элементам Старт подмножества и Количество элементов подмножества, в 

контекстном меню выберите пункт Representation, затем пункт 132; 
к) значения элементов управления данных пока не изменяйте. 

 
 
Блок-диаграмма  
 

2. Постройте блок-диаграмму, как показано ниже. 
 

 

 Выберите функцию Random Number (0-1), расположенную в палитре Functions → Numeric. Эта функция будет ге-
нерировать случайное число в пределах от 0 до 1. 

 Выберите цикл For, расположенный в палитре Functions → → Structures. Этот цикл на терминале выхода накапли-
вает массив из 10 случайных чисел. Терминалу количества итераций присвойте значение 10. 

  Выберите функцию Array Subset, расположенную в палитре Functions → Array. Эта функция выдает подмноже-
ство массива, начиная со значения, введенного в элементе Старт подмножества, и будет содержать количество элементов, 
указанное в элементе Количество элементов подмножества. 

3. Сохраните ВП под именем Работа с массивами. 
 



 

Запуск ВП 
 

4. Перейдите на лицевую панель, измените значения элементов управления и запустите ВП. 
Цикл For совершит 10 итераций. Каждая итерация создаст случайное число и сохранит его в терминале выхода из цик-

ла. В элементе Массив случайных чисел отобразится массив из 10 случайных чисел. ВП умножит каждое значение этого мас-
сива на число, введенное в элемент управления Масштабный коэффициент, для создания массива, отображаемого в инди-
каторе Конечный массив. ВП выделит подмножество из получившегося массива, начиная со значения в элементе Старт 
подмножества длиной, указанной в элементе Количество элементов подмножества, и отобразит это подмножество в ин-
дикаторе Подмножество массива. 

5. Закройте ВП.  
 

Задание  5.2. Создать ВП согласно Вашему варианту  
 

№ 
варианта Содержание задания 

1 Создайте ВП, который полностью изменяет порядок 
элементов в массиве, содержащем 10 случайных чисел. 
Например, элемент массива с индексом 0 становится 
элементом массива с индексом 9, а элемент массива с 
индексом 1 становится элементом массива с индексом 
8, и так далее. Для изменения порядка данных в масси-
ве следует использовать функцию Reverse ID Array, 
расположенную в палитре Functions → Array 

2 Создайте ВП, который генерирует одномерный массив 
и затем попарно перемножает элементы, начиная с 
элементов с индексами 0 и 1 и т.д., а затем выводит 
результаты в массив элементов отображения данных. 
Например, входной массив имеет значение {1, 23, 10, 5, 
7, 11}, а в результате получается массив {23, 50,77}. 
Используйте функцию Decimate ID Array, расположен-
ную в палитре Functions → Array 

3 
 

Создайте ВП, который генерирует одномерный массив, 
содержащий 80 случайных чисел, и выдает часть мас-
сива, начиная с индекса 15 до индекса 60. На лицевую 
панель вывести массив случайных чисел и  полученный 
массив 

4 
 
 

Создайте ВП, который генерирует одномерный массив  
случайных чисел до тех пор, пока не нажата кнопка на 
лицевой панели. На лицевую панель вывести получен-
ный массив и его размерность 

5 Создайте ВП, который генерирует двумерный массив 
случайных чисел, содержащий 3 строки и 10 столбцов 

6 
 

Создайте ВП, который генерирует одномерный массив 
случайных чисел и сортирует полученный массив в 
порядке возрастания.  На лицевую панель вывести мас-
сив случайных чисел и  отсортированный массив. Для 
сортировки элементов в массиве следует использовать 
функцию Sort 1D Array, расположенную в палитре 
Functions → Array 

7 
 

Создайте ВП, который генерирует одномерный массив 
случайных чисел и выводит максимальное значение 
полученного массива и его порядковый номер. Исполь-
зовать функцию Array Max & Min, расположенную в 
палитре Functions → Array 

8 
 

Создайте ВП, который генерирует одномерный массив 
случайных чисел и выводит минимальное значение 
полученного массива и его порядковый номер. Исполь-
зовать функцию Array Max & Min, расположенную в 
палитре Functions → Array 

9 Создайте ВП, который генерирует двумерный массив 
случайных чисел, содержащий 4 строки и 5 столбцов 

10 
 

Создайте ВП, который генерирует два одномерных 
массива случайных чисел и объединяет эти массивы в 



 

двумерный массив чисел. На лицевую панель вывести 
два исходных массива случайных чисел и двумерный 
массив, состоящий из элементов исходных массивов 

11 
 

Создайте ВП, который генерирует двумерный массив 
случайных чисел размерностью 5 × 6, и выдает часть 
этого  массива размерностью 4 × 5. На лицевую панель 
вывести исходный массив случайных чисел и  полу-
ченный массив 

12 Создайте ВП, который генерирует двумерный массив 
случайных чисел и осуществляет транспонирование  по-
лученного массива. На лицевую панель вывести массив 
случайных чисел и транспонированный массив. Для 
транспонирования массива используйте функцию Trans-
pose 2D Array, расположенную в палитре Functions →  
→ Array 

13 Создайте ВП, который полностью изменяет порядок 
элементов в массиве, содержащем 20 случайных чисел. 
Например, элемент массива с индексом 0 становится 
элементом массива с индексом 9, а элемент массива с 
индексом 1 становится элементом массива с индексом 
8, и так далее. Для изменения порядка данных в масси-
ве следует использовать функцию Reverse ID Array, 
расположенную в палитре Functions → Array 

14 Создайте ВП, который генерирует одномерный массив 
случайных чисел до тех пор, пока минимальный эле-
мент массива не станет равным числу, введенному в 
элемент управления на лицевой панели 

15 Создайте ВП, который создает двумерный массив чи-
сел размерностью 5 × 10 с помощью функции Initialize 
Array, расположенную в палитре Functions → Array 

 
Контрольные вопросы 

 

1. Из каких основных компонентов состоит Ваш ВП? 
2. Какие типовые приемы создания массива констант Вы знаете? 
3. Какие функции работы с массивами Вы знаете? 
4. Что такое полиморфные функции? 
5. Как создать многомерный массив? 
6. Какие функции создания массивов Вы знаете? 
7. Как создать двумерный массив в цикле For? 
8. Как объединить два одномерных массива в двумерный массив? 
9. Как объединить два одномерных массива в более длинный массив той же размерности? 
10. Каково назначение элемента Старт подмножества в подпрограмме ВП?  
11. Какая функция генерирует случайное число в пределах от 0 до 1? 
12. Как выбирается количество элементов подмножества в подпрограмме ВП? 
 

 
 
 

СОЗДАНИЕ КЛАСТЕРОВ ИЗ ЭЛЕМЕНТОВ УПРАВЛЕНИЯ И ОТОБРАЖЕНИЯ ДАННЫХ. РАБОТА С КЛАСТЕРАМИ.  
МАСШТАБИРОВАНИЕ КЛАСТЕРА 

 

Цель занятия:  
• изучение типовых приемов создания кластеров и функций отображения кластеров; 
• создание кластеров на лицевой панели; 
• сборка и демонтирование кластеров с использованием функций обработки кластеров; 
• создание ВП, использующего полиморфизм в кластерах. 
 

ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 
 

Как и массив, кластер является структурой, группирующей данные. Однако в отличие от массива кластер может груп-
пировать данные различных типов (логические, числовые и т.д.). Объединение нескольких групп данных в кластер устраняет 
беспорядок на блок-диаграмме и уменьшает количество полей ввода/вывода данных, необходимых подпрограмме ВП. Мак-
симально возможное количество полей ввода/вывода данных ВП равно 28. Если лицевая панель содержит более 28 элемен-
тов, которые необходимо использовать в ВП, можно некоторые из них объединить в кластер и связать кластер с полем вво-

Занятие  № 6 



 

да/вывода данных. Как и массив, кластер может быть элементом управления или отображения данных, однако кластер не 
может одновременно содержать элементы управления и отображения данных. 

Создание кластеров из элементов управления и отображения данных. Для создания кластеров из элементов управ-
ления и отображения данных следует выбрать шаблон кластера в палитре Controls →  

→ Array & Cluster и поместить его на лицевую панель. После этого шаблон кластера следует заполнить элементами. Из-
менить размер кластера можно с помощью курсора. 

Ниже показан кластер, содержащий три элемента управления. 

 
 

Порядок элементов в кластере. Каждый элемент кластера имеет свой логический порядковый номер, не связанный с 
положением элемента в шаблоне. Первому помещенному в кластер элементу автоматически присваивается номер 0, второму 
элементу – 1 и так далее. При удалении элемента порядковые номера автоматически изменяются. 

Порядок элементов в кластере определяет то, как элементы кластера будут распределены по терминалам функций 
Bundle (объединения) и Unbundle (разделения) на блок-диаграмме. 

Посмотреть и изменить порядковый номер объекта, помещенного в кластер, можно, щелкнув правой кнопкой мыши по 
краю кластера и выбрав из контекстного меню пункт Reorder Controls In Cluster. Панель инструментов и кластер примут вид, 
показанный ниже на рисунке. 

В белом поле (1) указан текущий порядковый номер элемента, в черном (2) – новый порядковый номер. Для установки 
порядкового номера элемента нужно в поле ввода текста Click to set to ввести число и нажать на элемент. Порядковый номер 
элемента изменится. При этом корректируются порядковые номера других элементов. Сохранить изменения можно, нажав 
кнопку ОК (подтвердить) на панели инструментов.  

 

 
Создание кластера констант. На блок-диаграмме можно создать кластер констант, выбрав в палитре Functions → 

Cluster шаблон Cluster Constant и поместив в него числовую константу или другой объект данных, логический или строко-
вый. 

Функции работы с кластерами. Для создания и управления кластерами используются функции, расположенные в палит-
ре Functions → CIuster. Функции Bundle (Связать) и Bundle by Name (Связать по названию) используются для сборки и управ-
ления кластерами. Функции Unbundle (Разделить) и Unbundle by Name (Разделить по названию) используются для разборки 
кластеров. 

Эти функции также можно вызвать, щелкнув правой кнопкой мыши по терминалу данных кластера и выбрав из контек-
стного меню подменю Cluster Tools (Инструменты кластеров). Функции Bundle и Unbundle автоматически содержат пра-
вильное количество полей ввода/вывода данных. Функции Bundle by Name и Unbundle by Name в полях ввода/вывода данных 
содержат имя первого элемента кластера.  

Иногда удобно  поменять массивы на кластеры и наоборот, поскольку LabVIEW включает в себя намного больше 
функций, работающих с массивами, чем с кластерами. Для преобразования кластера в массив служит функция Кластер в 
массив (Cluster to Array). Обратная операция осуществляется с помощью функции Массив в кластер (Array to Cluster). 
Функция Кластер в массив конвертирует кластер с количеством элементов N одного типа данных в массив с количеством 
элементов N того же типа данных. Индекс массива соответствует порядковому номеру в кластере (т.е. нулевой элемент 
кластера становится значением массива с индексом 0). Следует обратить внимание, что при использовании этой функции 
все элементы в кластере должны быть одного типа.       

Функция Массив в кластер преобразует одномерный массив с числом элементов N в кластер с числом элементов N того 
же типа данных. Для включения этой функции необходимо щелкнуть правой кнопкой мыши по терминалу Массив в 
Кластер и выбрать опцию Размер кластера (Cluster Size) для установления размера выходного кластера, поскольку класте-



 

ры, в отличие от массивов, не устанавливают свой размер автоматически. Размер кластера по умолчанию равен 9. Если мас-
сив имеет меньшее количество элементов, чем это определено размером кластера, LabVIEW автоматически создаст допол-
нительные элементы кластера со значениями по умолчанию для типа данных кластера. Однако, если количество элемен-
тов входного массива больше величины, установленной в окне размера кластера, то проводник блок-диаграммы, идущий 
к выходному кластеру, будет разорванным, пока не будет отрегулирован его размер. 

Задание  6.1. ВП Работа с кластерами 
 

Лицевая панель 
 

1. Откройте новый ВП и создайте лицевую панель, как показано ниже: 

 
 
 
а)  поместите на лицевую панель кнопку «Стоп» и круглый светодиод; 
б)  из палитры Controls → Array & Cluster выберите шаблон кластера; 
в)  объекты лицевой панели, показанные на иллюстрации, поместите в шаблон кластера; 
г)  создайте и переименуйте копию элемента Кластер в Модифицированный Кластер. После этого щелкните правой 

кнопкой мыши по границе шаблона кластера Модифицированный Кластер и выберите из контекстного меню пункт Change 
to Indicator; 

д)  повторите пункт «г» для создания элемента Маленький кластер; измените его, как показано на рисунке. 
2. Проверьте порядковые номера элементов в кластерах Кластер и Маленький кластер. Порядковые номера элементов 

кластера Модифицированный кластер и Кластер должны совпадать: 
а)  щелкните правой кнопкой мыши по границе шаблона каждого кластера, из контекстного меню выберите пункт 

Reorder Controls in Cluster; 
б)  порядковые номера элементов установите, как показано ниже. 

 
 
Блок-диаграмма 
 

3. Создайте блок-диаграмму, как показано ниже. 



 

 

 Из палитры Functions → Cluster выберите функцию Unbundle. Эта функция разъединяет кластер Кластер. Изме-
ните размер этой функции до четырех полей ввода данных или соедините терминал данных кластера с функцией для автома-
тического добавления полей ввода данных. 

 Из палитры Functions → Cluster выберите функцию Bundle. Эта функция объединит элементы в кластер Малень-
кий кластер. 

 Из палитры Functions → Cluster выберите функцию Unbundle by Name. Эта функция выделит два элемента из 
кластера Кластер. Измените размер функции до двух полей вывода данных. Если имена в полях вывода данных отличаются 
от показанных на иллюстрации, следует щелкнуть правой кнопкой мыши по имени элемента и в контекстном меню войти в 
раздел Select Item. 

 Из палитры Functions → Numeric выберите функцию Increment. Эта функция добавит 1 к значению элемента Число. 

 Из палитры Functions → Boolean выберите функцию Not. Эта функция выдаст логическое отрицание элемента Ло-
гический 1. 

 Из палитры Functions → Cluster выберите функцию Bundle by Name. Эта функция изменит значения элементов 
Число и Логический1 в кластере Кластер и создаст кластер Модифицированный кластер. Измените размер этой функции на 
два поля ввода данных. Если имена в полях вывода данных отличаются от показанных на иллюстрации, следует щелкнуть 
правой кнопкой мыши по имени элемента и в контекстном меню войти в раздел Select Item. 

4. Сохраните ВП под именем Работа с кластерами. vi.  
5. Перейдите на лицевую панель и запустите ВП. 
6. Поменяйте значения элементов в кластере Кластер и запусти-те ВП. 
7. Закройте ВП. 

 

Контрольные вопросы 
 

1. Из каких основных компонентов состоит Ваш ВП? 
2. Что понимается под термином «Кластер»? 
3. Какие типовые приемы создания кластеров Вы знаете? 
4. Какие функции отображения кластеров Вы знаете? 
5. Как создать кластер на лицевой панели? 
6. Как собираются и демонтируются кластеры? 
7. Какие функции обработки кластеров Вы знаете? 
8. Что такое полиморфизм в кластерах? 
9. Как создать модифицированный кластер? 
10. Каково основное отличие кластера от массива? 
11. Каков порядок размещения элементов в кластере? 
12. Как посмотреть и изменить порядковый номер объекта, помещенного в кластер? 
13. Как изменить количество полей ввода/вывода в кластере? 
14. Как устанавливают размер кластера? 
15. Каков размер кластера по умолчанию? 
16. Как создать и переименовать копию элемента «Кластер»? 
 



 

Занятие  № 7 
 

ГРАФИЧЕСКОЕ ОТОБРАЖЕНИЕ ДАННЫХ 
 

Цель занятия:  
• приобрести навыки по использованию цикла For и графика Диаграмм для получения и отображения данных; 
• создать массив, используя свойство автоиндексации цикла For и вывести данные массива на график Осциллограмм; 
• отобразить данные на графике и проанализировать их. 

 

ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 
 

График Диаграмм. График Диаграмм (Waveform Chart) (волнообразный график) – специальный элемент отображения 
данных в виде одного и более графиков. График Диаграмм расположен на палитре Controls → Graph. На рис. 7.1 показан 
пример Графика Диаграмм с двумя графиками: экспериментальные данные и их бегущее среднее значение. 

 

 
 

Рис. 7.1. График Диаграмм: 
1 – название (Label); 2 – шкала Y (Y – scal); 3 – шкала X (X – scale); 4 – панель управления шкалами (Scale legend); 5 – палитра инструмен-

тов для работы с графиком (Graph palette); 6 – панель управления графиком (Plot legend) 
 
График Диаграмм использует три различных режима отображения данных: strip chart (ленточный), scope chart (пре-

дельный) и sweep chart (амплитудный). Режим по умолчанию – strip chart.  
Задание режима осуществляется щелчком правой клавишей мыши по диаграмме и выбором пункта Advanced → Update 

Mode из контекстного меню.  
Режим strip chart представляет собой экран, прокручиваемый слева направо, подобно бумажной ленте. В режиме scope 

chart по достижении правой границы поле графика очищается, и заполнение диаграммы начинается с левой границы. Режим 
sweep chart, в отличие от режима scope chart, не очищает поле графика, а отделяет новые данные от старых вертикальной 
линией – маркером.  

 

 
 

Для создания диаграмм достаточно соединить поле вывода скалярной величины с терминалом данных графика Диа-
грамм.  

 

 
 

График Диаграмм может отображать несколько графиков. Для объединения отображаемых данных используется функ-
ция Bundle (объединение), расположенная в палитре Functions → CIuster. Например, блок-диаграмма, показанная ниже, с 



 

помощью функции Bundle объединяет выходные данные трех подпрограмм ВП для последующего отображения на графике 
Диаграмм. 

 
 

График Осциллограмм и двухкоординатный график Осциллограмм. С помощью графиков в виде осциллограмм 
ВП обычно отображает накопленные в массив данные. На рис. 7.2 показаны элементы графика. 

График Осциллограмм (Waveform Graph) и двухкоординатный график Осциллограмм (XY Graph) расположены в палит-
ре Controls → Graph. График Осциллограмм отображает только однозначные функции, такие как y = f (x), с точками, равно-
мерно распределенными по оси X. Двухкоординатный график Осциллограмм отображает любой набор точек, будь то равно-
мерно распределенная выборка во времени или нет.  

 

 
 

Рис. 7.2. График Осциллограмм: 
1 – панель управления свойствами осциллограмм (Plot legend); 2 – курсор (Cursor); 3 – основная размерная сетка (Grid mark); 4 – дополни-

тельная размерная сетка (Mini-grid mark); 5 – палитра элементов управления графиком (Graph palette);  
6 – панель перемещения курсора (Cursor mover); 7 – панель управления свойствами курсора (Cursor legend); 8 – панель управления шкалой 

(Scale legend); 9 – шкала X (X – scale); 10 – шкала Y (Y – scale); 11 – собственная метка графика (Label) 
Одиночный график Осциллограмм работает с одномерными массивами и представляет данные массива в виде точек на 

графике, с приращением по оси X равным 1 и началом в точке x = 0. Графики также отображают кластеры с установленным 
начальным значением х0, dх и массивом данных по шкале у.  

Для отображения множества осциллограмм необходимо изменить размер панели Plot legend (легенда графика). График 
множества Осциллограмм используется с целью экономии пространства на лицевой панели и для сравнения осциллограмм 
данных между собой. 

График множества Осциллограмм работает с двумерными массивами данных, где каждая строка массива есть одиноч-
ная осциллограмма данных и представляет данные массива в виде точек на графике, с приращением по оси X равным 1 и 
началом в точке х = 0. 

Графики множества Осциллограмм отображают также и кластеры с установленным начальным значением х0, dх и мас-
сивом данных, содержащим кластеры. Каждый кластер содержит массив точек, отображающих данные по шкале Y. Для соз-
дания массива кластеров следует использовать функцию Bundle, которая объединяет массивы в кластеры. Далее с помощью 
функции Build Array создается массив кластеров. Можно также использовать функцию Build Cluster Array, которая создает 
массив кластеров с определенными полями ввода данных.  

Одиночные двухкоординатные графики Осциллограмм. Одиночный двухкоординатный график Осциллограмм ра-
ботает с кластерами, содержащими массивы x и у. Двухкоординатный график Осциллограмм также воспринимает массивы 
точек, где каждая точка является кластером, содержащим значения по шкалам х и у. 

Двухкоординатные графики множества Осциллограмм. Двухкоординатные графики множества Осциллограмм ра-
ботают с массивами осциллограмм, в которых осциллограмма данных является кластером, содержащим массивы значений х 
и у. Двухкоординатные графики множества Осциллограмм воспринимают также массивы множества осциллограмм, где каж-
дая осциллограмма представляет собой массив точек. Каждая точка – это группа данных, содержащая значения по х и у. 

 

Задание  7.1. ВП Температурный анализ 
 

Ниже приведена последовательность действий для создания ВП, который измеряет температуру каждые 0,25 с в тече-
ние 10 с. В процессе измерения ВП в реальном масштабе времени отображает данные на графике Диаграмм. После заверше-



 

ния измерений ВП выводит данные на график Осциллограмм и рассчитывает минимальную, максимальную и среднюю тем-
пературу. Кроме того, ВП отображает аппроксимацию осциллограммы температуры. 

Лицевая панель 
 

1. Откройте новый ВП и создайте лицевую панель, как показано ниже на рисунке. 
 

 
 
а)  Выберите график Диаграмм (Waveform Chart) из палитры Controls → → Graph и поместите его на лицевую панель. На 

графике Диаграмм будет отображаться значение температуры в реальном масштабе времени. Введите текст Температура в 
поле собственной метки графика. 

Обратите внимание на то, что на панели управления графиком (chart legend) введен текст Plot 0. Измените текст на 
Температура с помощью инструмента ВВОД ТЕКСТА 

Введите текст Градусы F в поле собственной метки оси ординат графика. 
Введите текст Время (с) в поле собственной метки оси абсцисс графика. 
б)  Щелкните правой кнопкой мыши по графику и выберите пункт Properties. Появится диалоговое окно Chart 

Properties (свойства графика). Перейдите на закладку Format and Precision и установите значение параметра Digits of 
precision (порядок точности) равное 2.  

 
 

в)  Нажмите на закладку Plots и установите стиль точек на графике диаграмм в виде х. 
 



 

 
 

г)  Выберите график Осциллограмм (Waveform Graph) из палитры Controls → Graph и поместите его на лицевую па-
нель. На графике Осциллограмм будут отображаться значения температуры по завершении работы ВП и их аппроксимация. 
С помощью инструмента ПЕРЕМЕЩЕНИЕ измените размер панели plot legend. С помощью инструмента ВВОД ТЕКСТА 
переименуйте График 0 в Промежуточный, а График 1 – в Аппроксимированный. 

Измените названия осей и собственные метки графика осциллограмм согласно рисунку лицевой панели. 
Установите стиль точек осциллограммы Промежуточный в виде маленького квадрата. 
Пока не создавайте элементы отображения данных Среднее, Макс, и Мин. 
 

Блок-диаграмма 
 

2. Постройте блок-диаграмму, как показано ниже. 

 

 Выберите Термометр.vi, созданный в задании 3.2, и поместите его на блок-диаграмму. Этот ВП выдает одно из-
меренное значение температуры. 

 В палитре Functions → Time & Dialog выберите функцию Wait Until Next ms Multiple. С помощью числовой кон-
станты на поле ввода функции подайте значение 250, что заставит цикл For выполняться каждые 0,25 с. 

 В палитре Functions → Array выберите функцию Array Max & Min. Эта функция определяет минимум и максимум 
температуры. 

 В палитре Functions → Analyze → Mathematics → Probability and Statistics выберите ВП Mean VI. Этот ВП опреде-
ляет среднее значение измеренной температуры. 

Щелкните правой кнопкой мыши по полю вывода данных Array Max & Min и ВП Mean VI и выберите в контекстном 
меню пункт Create → Indicator для создания элементов Максимальное, Минимальное и Среднее. 

 В палитре Functions → Analyze → Mathematics → Curve Fitting (сглаживание) выберите ВП General Polynomial Fit 
(основная полиномиальная аппроксимация). Этот ВП проведет аппроксимацию осциллограммы температуры. 

 В палитре Functions → Cluster выберите функцию Bundle. Нажмите и удерживайте клавишу <Ctrl> во время пере-
мещения функции для создания ее копии. Эта функция объединяет элементы в одномерный кластер. Элементы содержат 
начальное значение x0= 0, Дx и массив значений температуры по у. Значение dx = 0,25 необходимо для того, чтобы ВП выво-
дил значения  температуры на график Осциллограмм каждые 0,25 секунды. 

 В палитре Functions → Array выберите функцию Build Array. Эта функция создает массив кластеров из группы 
измеренных данных температуры и их аппроксимации. 

3. Сохраните ВП под именем «Анализ температуры». 
 

Запуск ВП 
 

4. Перейдите на лицевую панель и запустите ВП. 



 

На графике Осциллограмм одновременно появятся осциллограммы данных температуры и их аппроксимации. 
5. Поменяйте значения константы порядка аппроксимации на блок-диаграмме и снова запустите ВП. 
6. Измените вид представления осциллограмм: 
а)  Щелкните правой кнопкой мыши по надписи Промежуточный на панели Plot legend и выберите в контекстном ме-

ню Common Plots → Scatter Plot (экспериментальные точки); 
б)  Щелкните правой кнопкой мыши по надписи Аппроксимированный на панели Plot legend и в разделе Ваr Plots кон-

текстного меню выберите вторую иконку в средней строке. Получившийся график осциллограмм должен оказаться подоб-
ным изображенному ниже. 

 

 
 

7.  Сохраните и закройте ВП. 
Задание  7.2. Создать ВП согласно Вашему варианту 
 

№ 
варианта Содержание задания 

1 
 

Создайте ВП, который генерирует двумерный массив слу-
чайных чисел размерностью 5 × 10 и отображает на графике 
строки полученного массива 

2 
 

Создайте ВП, который генерирует одномерный массив слу-
чайных чисел и полученные значения выводит на график. 
Также отображает аппроксимацию полученных данных 

3 
 

Создайте ВП, который генерирует двумерный массив слу-
чайных чисел размерностью 11 × 4 и отображает на графике 
столбцы полученного массива 

4 Создайте ВП, который генерирует одномерный массив слу-
чайных чисел в диапазоне от 0 до 100 (состоящий из 7 эле-
ментов) до тех пор, пока минимальное значение массива не 
станет равным числу, введенному в элемент управления на 
лицевой панели. На лицевую панель вывести полученный 
массив, его график, минимальный элемент и число итераций 

5 
 

Создайте ВП, который генерирует два одномерных массива 
случайных чисел, затем объединяет эти массивы в двумер-
ный массив чисел и отображает на графике строки получен-
ного массива 

6 
 

Создайте ВП, который генерирует одномерный массив  слу-
чайных чисел до тех пор, пока не нажата кнопка на лицевой 
панели. На лицевую панель вывести полученный массив, его 
размерность и график 

7 
 

Создайте ВП, который на ЛП содержит кластер и массив 
элементов отображения (Подмножество массива). Кластер 
состоит из 2 регуляторов (старт подмножества и количество 
элементов подмножества) и массива числовых данных – Мас-
сив 1. Из Массива 1 выделить подмножество, начиная с эле-
мента Старт подмножества, содержащее количество элемен-
тов, заданное с регулятора Количество элементов подмноже-
ства, и поместить в массив – Подмножество массива. На гра-
фике Осциллограмм отображаются элементы Массива 1 и Под-
множество массива 

8 
 

Создайте ВП, который измеряет температуру каждые 20 с в 
течение 2 мин и отображает значения температуры в реаль-
ном масштабе времени 



 

9 
 

Создайте ВП, который на ЛП содержит кластер, состоящий 
из 10 числовых элементов управления. На графике отобрази-
те значения, введенные с элементов управления 

10 
 

Создайте ВП, который на ЛП содержит кластер, состоящий 
из 10 числовых элементов управления. На графике отобрази-
те значения, введенные с элементов управления 

11 
 

Создайте ВП, который генерирует двумерный массив слу-
чайных чисел размерностью 5 × 6 и выдает часть этого  мас-
сива размерностью 4 × 5. На лицевую панель вывести исход-
ный массив случайных чисел, полученный массив и их гра-
фики 

12 Создайте ВП, который на ЛП содержит кластер, состоящий 
из 2-х массивов числовых элементов управления. Элементы 
этих массивов отобразите на графике 

13 Создайте ВП, который генерирует двумерный массив слу-
чайных чисел размерностью 3 × 7 и отображает на графике 
строки полученного массива 

14 Создайте ВП, который генерирует одномерный массив  слу-
чайных чисел в диапазоне от 0 до 100 (состоящий из 7 эле-
ментов) до тех пор, пока максимальное значение массива не 
станет равным числу, введенному в элемент управления на 
лицевой панели. На лицевую панель вывести полученный 
массив, его график, максимальный элемент и число итераций 

15 Создайте ВП, который генерирует одномерный массив слу-
чайных чисел и сортирует полученный массив в порядке воз-
растания. На лицевую панель вывести массив случайных чи-
сел, отсортированный массив и их графики 

 
 

Контрольные вопросы 
 

1. Назовите основные элементы графика Диаграмм. Для чего он предназначен? 
2. Назовите основные элементы графика Осциллограмм. Для чего он предназначен? 
3. Какие режимы отображения данных на графике Диаграмм Вы знаете? 
4. С какими данными работает график множества Осциллограмм? 
5. Какая функция определяет среднее значение массива? 
6. Какая функция определяет минимальное и максимальное значение массива? 
7. Какой ВП служит для аппроксимации графика Осциллограмм в Вашем ВП? 
8. Как установить определенный стиль точек, цвет и тип линии на графике? 

 



 

2. СТРОКИ И ТАБЛИЦЫ. ФАЙЛОВЫЙ ВВОД/ВЫВОД 
 

 
 
 
 

Занятие  № 8 
 

СТРОКИ И ТАБЛИЦЫ 
 

Цель занятия:  
• изучить создание строковых элементов управления и отображения данных; 
• приобрести навыки по использованию функций обработки строк; 
• изучить создание элемента управления и отображения Таблица. 

 
 
 
 

Строки. Строки – это последовательность отображаемых и неотображаемых ASCII символов. Строки обеспечивают не-
зависимый от платформы формат обмена данными. Некоторые из наиболее распространенных строковых приложений вклю-
чают в себя: 

• Создание простых текстовых сообщений. 
• Передачу числовых данных в приборы в виде строк символов и преобразование строк в числовые данные. 
• Сохранение числовых данных на диск. Чтобы сохранять числовые данные в виде файла ASCII, необходимо перед 

записью преобразовать их в строки. 
• Диалоговые окна инструкций и подсказок. 
На лицевой панели строки появляются в виде таблиц, полей ввода текста и меток.  
Создание строковых элементов управления и отображения данных. Для работы с текстом и метками используются 

строковые элементы управления и отображения данных, расположенные в палитре Controls →  → String & Path. Создание и 
редактирование текста в строке производится с помощью инструментов УПРАВЛЕНИЕ и ВВОД ТЕКСТА. Для изменения 
размера строкового объекта на лицевой панели используется инструмент ПЕРЕМЕЩЕНИЕ. Для экономии места на лицевой 
панели можно использовать полосу прокрутки. Для этого необходимо щелкнуть правой кнопкой мыши по строковому объ-
екту и выбрать в контекстном меню пункт Visible Items → Scrollbar (полоса прокрутки). 

Тип отображения строкового объекта выбирается в его контекстном меню. Типы отображения строки и примеры запол-
нения поля ввода текста показаны в таблице ниже. 

 
 

Тип  
отображения Описание Пример текста 

Режим стандарт-
ного отображения 
(Normal Display) 

Отображает стандартные ASCII 
коды, используя шрифт эле-
мента управления. Управляю-
щие коды для печати выводят-
ся на экран в виде квадратов 

There are four dis-
play types 

Режим отображе-
ния с обратным 
слэшем непеча-
таемых управ-
ляющих кодов (‘\’ 
Codes Display) 

Выводит \ для всех непечатае-
мых управляющих кодов 
 

There\sare\sfour\s 
display \stypes  
 

Режим скрытого 
отображения тек-
ста (Password Dis-
play) 

Выводит * для всех кодов тек-
стового пространства 

****************
**************** 

Режим отобра-
жения 16-тирич-
ных ASCII кодов 
(Hex Display) 

Выводит значение ASCII кода 
для каждого символа 

5468 6572 6520 
6172 6520 666F 

 
Функции работы со строками. Для редактирования и управления строками на блок-диаграмме следует пользо-

ваться функциями обработки строк, расположенными в палитре Functions → String. Некоторые из функций работы 
со строками рассмотрены ниже: 

• String Length – выдает количество символов в строке, включая пробелы. Например, функция String Length выдает 
значение 19 для приведенного ниже текста: The quick brown fox (Быстрая чернобурка).  

ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 



 

• Concatenate Strings (связать строки) – объединяет строки и одномерные массивы строк в отдельную строку. Для уве-
личения полей ввода данных функции следует изменить ее размер. Например, объединив предыдущую строку со следую-
щим массивом строк: 

 

 
 

функция Concatenate Strings на выходе выдает следующую строку: The quick brown fox jumped over the lazy dog (Быстрая 
чернобурка перепрыгнула через ленивую собаку). 

• String Subset (подстрока) – выдает подстроку определенной длины length, начиная со значения offset (смещение). 
Смещение первого элемента в строке равно 0. Например, если на поле ввода данных функции подать предыдущую строку, то 
функция String Subset при offset = 4 и length = 5 выдаст значение: quick, 

• Match Pattern (похожая структура) – ищет повторяющуюся последовательность, поданную на поле ввода данных 
regular expression, в строке начиная со значения смещения offset, и, если находит соответствие, разбивает строку на три под-
строки. Если соответствие не найдено, поле вывода данных match substring является пустым, а значение поля вывода данных 
offset past match (смещение повторяющейся последовательности в строке) равно –1. Например, на поле regular expression 
(шаблон подстроки) подается значение, а строка на входе VOLTS DC: + 1.22863Е + 1. 

Функция Match Pattern выдаст величины before substring (перед подстрокой) VOLTS DC, match substring (шаблон под-
строки) : и after substring (после подстроки) + 1.22863Е + 1, а также offset past match равный 9. 

Преобразование числовых данных в строку. Для преобразования числовых данных в строковые используются ВП 
Build Text Express и функция Format Into String (конвертирование в строку). Обе эти функции имеют входные и вы-
ходные кластеры ошибок.  

 

Примечание. При недостатке места на блок-диаграмме лучше использовать функцию Format Into String. 
 

Экспресс-ВП Build Text, расположенный в палитре Functions → Express → Output,  производит объединение входных 
строк. Если входные величины имеют не строковый тип данных, то они преобразуются в строку в соответствии с настройка-
ми этого экспресс-ВП. 

Функция Format Into String преобразует параметры любого формата, такие как числовые данные, в строку. Для увели-
чения количества параметров следует изменить размер функции. 

Для преобразования строки в числовые данные следует использовать функцию Scan From String. Функция Scan From 
String преобразует строку, содержащую допустимые числовые символы, такие как 0-9, +, –, е, Е и разделитель, в данные чи-
слового формата. Функция начинает просмотр строки, подаваемой на поле ввода данных input string, с номера символа, зада-
ваемого на поле initial search location (внутренний поиск положения строки). Функция может просматривать входящую стро-
ку различных типов данных, таких как числовые или логические данные, основываясь на формате строки. Для увеличения 
количества полей вывода данных следует изменить размер функции. 

Таблицы. Элемент управления Таблица, расположенный в палитре Controls → List & Table, предназначен для создания 
таблиц на лицевой панели. Каждая ячейка находится в строке и столбце таблицы. Поэтому таблица отображает двумерный 
массив строк. На рис. 8.1 показана таблица и ее составные части. 

 
Рис. 8.1. Таблица: 

1 – ячейка таблицы; 2 – заголовок столбца; 3 – вертикальная полоса прокрутки;  
4 – горизонтальная полоса прокрутки; 5 – заголовок строки; 6 – индекс по  

горизонтали; 7 – индекс по вертикали 
 

Для инициализации значений ячеек таблицы используется инструмент УПРАВЛЕНИЕ или ВВОД ТЕКСТА, с по-
мощью которых достаточно ввести текст в выделенную ячейку. 

Таблица – это двумерный массив строк. Таким образом, для использования таблицы в качестве элемента отображе-
ния данных необходимо двумерный массив чисел преобразовать в двумерный массив строк с помощью функции Number 
To Fractional String, расположенной в палитре Functions → String → Number Conversion. Заголовки строк и столбцов таб-
лицы автоматически не отображаются. Необходимо создать одномерный массив строк, содержащий заголовки строк и 
столбцов таблицы. 



 

 

Задание  8.1. ВП Компоновка строки 
 

Ниже приведена последовательность действий для создания ВП, который преобразует числовые данные в строку и объ-
единяет строку с другими строками в одну. Затем после поиска по шаблону выводится на экран индекс первого элемента 
после указанного символа. 

 

Лицевая панель 
 

1. Откройте новый ВП и оформите лицевую панель, как показано ниже на рисунке. Воспроизводить комментарии и 
подписи к элементам не обязательно. 

 
 

а)  Щелкните правой кнопкой мыши по элементу Строка 2 и выберите из контекстного меню режим отображения ‘\’ 
Codes Display. 

б)  Для элементов Длина строки и Смещение повторяющейся последовательности установите тип представления дан-
ных 132. 

 

Блок-диаграмма 
 

2. Постройте блок-диаграмму, как показано ниже: 

 

 Выберите функцию Format Into String, расположенную в палитре Functions → String. Эта функция преобразует 
число в строку. 

а)  Щелкните правой кнопкой мыши по функции Format Into String и выберите пункт Edit Format String для вызова со-
ответствующего диалогового окна. 

б)  Выделите опцию Use specified precision (использовать определенную точность) и в поле ввода текста введите значе-
ние 4 для преобразования элемента Число в строку с четырьмя знаками после запятой. 

в)  Нажмите на кнопку ОК. LabVIEW создаст формат строки %.4f, используя выбранную опцию. 

г)  С помощью инструмента ВВОД ТЕКСТА введите пробел с обеих сторон %.4f и нажмите клавиши <Shift + Enter>. 
Таким образом, на элементе Комбинированная строка числовые данные появятся с пробелами с обеих сторон. 

д)  Щелкните правой кнопкой мыши по константе и выберите режим отображения ‘\’ Codes Display из контекстного ме-
ню. Введенные пробелы заменятся на \. 



 

 Выберите функцию Concatenate Strings, расположенную в палитре Functions → String. Эта функция объединит 
входящие в нее строки в одну. 

 Выберите функцию String Length, расположенную в палитре Functions → String. Эта функция выдаст значение 
количества символов в объединенной строке Комбинированная строка. 

 Выберите функцию Match Pattern, расположенную в палитре Functions → String. Эта функция осуществляет по-
иск в элементе Строка 2 по шаблону : (двоеточие). 

е) Щелкните правой кнопкой мыши по полю regular expression (постоянное выражение) и выберите пункт контекстного 
меню Create → Constant, введите двоеточие и нажмите на клавиши <»Shift + Enter>. 

 
Иконка ВП и соединительная панель 
 

3. Перейдите на лицевую панель и создайте иконку и соединительную панель для использования созданного ВП в каче-
стве подпрограммы в других ВП.  

4. Сохраните ВП под именем Компоновка строки.vi. Этот ВП будет использоваться позднее. 
Запуск ВП 

 

5. Измените значение элементов на лицевой панели и запустите ВП. 
ВП объединит элементы: Заголовок, Число и Завершение строки в строку Комбинированная строка и выдаст значение 

Длины строки. 
ВП также найдет месторасположение подстроки : в элементе Строка 2. При выполнении ВП выводит на экран индекс пер-

вого элемента после двоеточия в элемент Смещение повторяющейся последовательности. 
6. Сохраните и закройте ВП. 

 

Задание  8.2. Создать ВП, согласно Вашему варианту 
 

№ 
варианта Содержание задания 

1 Создайте ВП, который генерирует двумерный массив 
случайных чисел размерностью 5 × 40 и записывает 
полученный массив в таблицу. Таблица должна содер-
жать заголовки для каждого столбца 

2 Создайте ВП, который генерирует двумерный массив 
случайных чисел размерностью 3 × 10 и записывает 
полученный массив в таблицу. Таблица должна содер-
жать заголовки для каждого столбца 

3 
 

Создайте ВП, который объединяет 3 произвольные  
строки в одну строку, считает количество символов 
полученной строки и выдает подстроку определенной 
длины, указанной с ЛП 

4 Создайте ВП, который генерирует двумерный массив 
случайных чисел размерностью 5 × 6, транспонирует 
его и записывает в таблицу 

5 Создайте ВП, который объединяет 2 одномерных мас-
сива строк в одну отдельную строку 

6 
 

Создайте ВП, который объединяет 2 произвольные  
строки в одну строку и выдает подстроку определенной 
длины, указанной с ЛП 

7 Создайте ВП, который объединяет 2 одномерных мас-
сива строк в одну отдельную строку 

8 Создайте ВП, который объединяет 4 строки, содержа-
щие числовые данные, в строку 

9 Создайте ВП, который считает количество символов 
строки, введенной на ЛП 

10 
 

Создайте ВП, который генерирует 2 одномерных мас-
сива случайных чисел, объединяет эти массивы в дву-
мерный массив и помещает его в таблицу 



 

11 Создайте ВП, который объединяет 3 одномерных мас-
сива строк в одну отдельную строку 

12 Создайте ВП, который объединяет 4 произвольные 
строки в одну строку и выдает подстроку определенной 
длины, указанной с ЛП 

13 Создайте ВП, который генерирует двумерный массив 
случайных чисел размерностью 5 × 8 и записывает по-
лученный массив в таблицу. Таблица должна содержать 
заголовки для каждого столбца 

14 Создайте ВП, который объединяет 2 строки (1 – Авто-
матизация измерений, 2 – контроля и испытаний) в од-
ну строку и считает количество символов полученной 
строки 

15 Создайте ВП, который генерирует двумерный массив 
случайных чисел размерностью 6 × 8, транспонирует 
его и записывает в таблицу 

 

Контрольные вопросы 
 

1. Как создать строковый элемент управления и отображения данных? 
2. Назовите типы отображения строкового объекта. 
3. Назовите основные функции работы со строками. 
4. С помощью какой функции можно преобразовать числовые данные в строку? 
5. Какая функция позволяет подсчитывать количество символов в строке? 
6. Какая функция позволяет объединять строки и одномерные массивы строк в отдельную строку? 
7. Как создать элемент управления Таблица? Для чего он предназначен? 
8. Какая функция позволяет преобразовывать двумерный массив чисел в двумерный массив строк? 

 

Занятие  № 9 
 

ФАЙЛОВЫЙ ВВОД/ВЫВОД 
 

Цель занятия:  
• изучить использование файловых функций ввода/вывода, записать данные в файл, считать данные из файла; 
• сохранить данные в файл в форме, доступной для редактора электронных таблиц или текстового редактора; 
• изучить использование файлового ввода/вывода высокого уровня. 

 
ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 

 

Функции файлового ввода/вывода производят файловые операции записи и считывания данных. Функции файлового 
ввода/вывода расположены в палитре Functions → File I/O и предназначены для: 

• Открытия и закрытия файла данных. 
• Считывания и записи данных из/в файл(а). 
• Считывания и записи данных из/в файл(а) в виде таблицы символов. 
• Перемещения и переименования файлов и каталогов. 
• Изменения характеристик файла. 
• Создания, изменения и считывания файлов конфигурации. 
Палитра функций файлового ввода/вывода, показанная ниже, разделена на три части: функции высокого уровня (high 

level File I/O), функции низкого уровня (low level File I/O) и подпалитра функций расширенных возможностей (advanced File 
I/O). 

 



 

 
 

Функции файлового ввода/вывода высокого уровня. Функции файлового ввода/вывода высокого уровня располо-
жены в верхней строке палитры Functions → File I/O. Они предназначены для выполнения основных операций по вво-
ду/выводу данных. Использование функций файлового ввода/вывода высокого уровня позволяет сократить время и усилия 
программистов при записи и считывании данных в/из файл(а). Функции файлового ввода/вывода высокого уровня выполня-
ют запись и считывание данных и операции закрытия и открытия файла. При наличии ошибок функции файлового вво-
да/вывода высокого уровня отображают диалоговое окно с описанием ошибок и предлагают на выбор: продолжить выпол-
нение программы или остановить ее.  

Функции файлового ввода/вывода высокого уровня включают в себя: 
• Write to Spreadsheet File (запись в крупноформатный файл) – преобразует 2D или ID массив числовых данных оди-

нарной точности в текстовую строку и записывает строку в новый или добавляет в уже существующий файл. При этом мож-
но также транспонировать данные. ВП открывает или создает файл перед записью и после всех операций закрывает его. Этот 
ВП используется для создания текстовых файлов, читаемых большинством текстовых редакторов и редакторов электронных 
таблиц. 

• Read From Spreadsheet File (чтение из крупномасштабного файла) – считывает определенное число строк от начального 
смещения start of read offset и преобразует данные в 2D массив числовых данных одинарной точности. ВП открывает файл 
перед чтением и после всех операций закрывает его. Этот ВП можно использовать для чтения таблицы символов, сохранен-
ной в текстовом формате. 

• Write Characters to File – записывает строку символов в новый файл или добавляет ее в уже существующий. ВП от-
крывает или создает файл перед записью и после всех операций закрывает его. 

• Read Characters From File – считывает количество символов number of characters от начального смещения start of 
read offset. ВП открывает файл перед чтением и после всех операций закрывает его. 

• Read Lines From File – считывает определенное число строк из текстового или бинарного файла с положения start of 
read offset. ВП открывает файл перед чтением и закрывает его после. 

• Binary File – читает и записывает файл в бинарном формате. Данные могут быть целочисленного типа или числовы-
ми данными одинарной точности с плавающей точкой. 

Однако из-за того, что функции данного класса объединяют весь процесс работы с файлами в один ВП, переделать их 
под определенную задачу бывает трудно. Для специфических задач следует использовать функции файлового ввода/вывода 
низкого уровня. 

Функции файлового ввода/вывода низкого уровня. Функции файлового ввода/вывода низкого уровня расположены 
в средней строке палитры Functions → FiIe I/O. Функции файлового ввода/вывода низкого уровня используются для созда-
ния нового или обращения к ранее созданному файлу, записи и считывания данных и закрытия файла. Функции низкого 
уровня работы с файлами поддерживают все операции, необходимые при работе с файлами.  

Функции файлового ввода/вывода низкого уровня включают в себя: 

 Open/Create/Replace File (открыть/создать/переместить файл) – открывает, перезаписывает существующий файл 
или создает новый. Если file path (путь размещения файла) не указан, ВП выводит на экран диалоговое окно, в котором мож-
но создать новый или выбрать уже существующий файл. 

 Read File – считывает данные из файла, определяемого по ссылке refnum, и выдает данные на поле вывода data, 
на поле count подается значение количества считываемых данных. Считывание данных начинается с места, определяемого 
элементами pos mode и pos offset, и зависит от формата файла. 

 Write File – записывает данные в файл, определяемый по ссылке refnum. Запись начинается с места, определяе-
мого полями ввода данных pos mode и pos offset для файла потока байтовых данных и указателем конца файла для файла 
протоколированных данных. 

 Close File – закрывает указанный в ссылке refnum файл. 
 
 
 



 

Обработка ошибок 
 

 Подпрограммы ВП и функции низкого уровня содержат информацию об ошибках. Для их обработки использу-
ются подпрограммы обработки ошибок, такие как Simple Error Handler VI (ВП Простой обработчик ошибок), расположен-
ный в палитре Functions Time & Dialog. Поля ввода error in и вывода error out информации об ошибках используются в каж-
дом ВП для обмена информацией об ошибках между ВП. 

Во время работы ВП LabVIEW проверяет наличие ошибок в каждом узле. Если LabVIEW не находит ошибок, то узел 
выполняется нормально. Если LabVIEW обнаруживает ошибку в одном узле, то его выполнение прерывается, а информация 
об ошибке передается следующему узлу. Следующий узел поступает так же, и в конце выполнения LabVIEW сообщает об 
ошибках. 

Сохранение данных в новом или уже существующем файле.  
В файл, созданный (или открытый) с помощью функций файлового ввода/вывода, можно записать данные лю-

бого типа. При необходимости доступа к файлу со стороны других приложений или пользователей следует записы-
вать данные в виде строки ASCII символов.  

Доступ к файлу можно осуществить программным путем или с использованием диалогового окна. Для доступа к файлу 
с помощью диалогового окна на поле ввода file path подпрограммы ВП Open/Create/Replace File VI не следует подавать дан-
ные. Путь к файлу состоит из имени дисковода, двоеточия, обратного слэша, разделяющего директории, и имени файла. На-
пример, H:\Laboratoria\lab1.vi в папке Laboratoria. 

Форматирование строк таблицы символов. 
Для того чтобы записать данные в файл формата электронной таблицы, необходимо переформатировать стро-

ковые данные в строку таблицы, содержащую разделители, такие как символ табуляции. Cимвол табуляции Tab con-
stant разделяет столбцы, а символ end of line разделяет строки. Оба символа расположены в палитре Functions → 
String. 

Функция Format Into File предназначена для форматирования строк, путей к файлам, числовых и логических данных в 
текст, а также для записи текста в файл. Часто эта функция используется вместо двух операций – форматирования строки с 
помощью функции Format Into String или ВП Build Text Express VI и записи результата с помощью функций Write Characters 
To File (записать в файл) или Write File (записать файл). 

Функция Format Into File предназначена для определения порядка, в котором данные записываются в тестовый файл. 
Однако ее нельзя применять для добавления данных в файл или перезаписи существующего файла. Для этих операций ис-
пользуется функция Format Into String совместно с функцией Write File.  

Ниже представлена блок-диаграмма, на которой подпрограмма ВП Open/Create/Replace File VI открывает файл. Цикл 
For выполняется пять раз. Функция Format Into String преобразует значения счетчика итераций и случайное число в строку. 
Также указываются символы Tab constant (табуляции) и End of Line Constant (конца строки) для создания двух столбцов и 
одной строки таблицы символов.  

 
Можно открыть данный текстовый файл в любом редакторе электронных таблиц для отображения на экране следую-

щей таблицы: 
 

 
 

Дополнительные функции работы с файлами (Advanced File I/O) расположены в палитре Functions → File I/O → Ad-
vanced File Functions и предназначены для управления отдельными операциями над файлами. 

 

Задание 9.1. ВП Запись файла 
 

Ниже приведена последовательность действий для создания ВП, который объединяет строку, числовые данные и 
модуль строки в файл.  

 

 



 

Лицевая панель 
 

1. Откройте новый ВП и оформите лицевую панель, как показано ниже: 
 

 
 
 

а)  В палитре Controls → String & Path выберите элемент отображения пути. Этот элемент отобразит путь к созданному 
файлу данных; 

б)  Щелкните правой кнопкой мыши по элементу Строка для записи и в контекстном меню выберите пункт Visible Items 
→ Scrollbar (полоса прокрутки). 

Блок-диаграмма 
 

2. Постройте следующую блок-диаграмму: 

 

 Выберите в разделе Functions → Select a VI ВП Компоновка cmpоки.vi, созданный в задании 8.1, и поместите его 
на блок-диаграмму. Этот ВП объединяет три строки в одну. 

 Поместите на блок-диаграмму подпрограмму ВП Open/ Create/Replace File VI, расположенную в палитре 
Functions → File I/O. Этот ВП выводит на экран диалоговое окно для создания файла. 

а) Щелкните правой кнопкой мыши по полю prompt (подсказка) и в контекстном меню выберите пункт Create → 
Constant для создания константы Введите имя файла. При запуске ВП появится окно выбора файла, которое будет называть-
ся Введите имя файла; 

б) Щелкните правой кнопкой мыши по входному полю function и в контекстном меню выберите пункт Create → 
Constant. Для выбора пункта выпадающего меню create or replace следует использовать инструмент УПРАВЛЕНИЕ. 

 Выберите функцию Write File, расположенную в палитре Functions → File I/O. Эта функция записывает объеди-
ненную строку в файл. 

 Выберите функцию Close File, расположенную в палитре Functions → File I/O. Эта функция закрывает файл. 

 Выберите подпрограмму ВП Simple Error Handler VI, расположенную в палитре Functions → Time & Dialog. 
Этот ВП проверяет кластер ошибок и выводит диалоговое окно при возникновении ошибки. 

3. Сохраните ВП под именем Запись файла.vi. 



 

 
Запуск ВП 

 

4. Поменяйте значения элементов управления на лицевой панели и запустите ВП. Появится диалоговое окно Введите 
имя файла. 

5. Введите в диалоговое окно название файла демофайл.txt и нажмите на кнопку Save или ОК. 
ВП запишет в файл данные из элементов Строка для записи, Число для записи и Единица измерения для записи. 
6.   Закройте ВП. 
 

Задание  9.2. ВП Чтение файла 
 

Ниже приведена последовательность действий для создания ВП, который читает файл, созданный в задании 9.1, и вы-
водит данные в строковом элементе отображения. 

 

Лицевая панель 
 

7.   Откройте новый ВП и создайте лицевую панель, используя элемент управления путем к файлу и строковый элемент 
отображения в палитре Controls → String & Path. 

 

 
 

Блок-диаграмма 
 

8.   Постройте следующую блок-диаграмму: 

 

 В палитре Functions → File I/O выберите подпрограмму Open/Create/Replace File VI. Этот ВП выведет на экран 
диалоговое окно, которое используется для создания и открытия файла. 

а)  Щелкните правой кнопкой мыши по входному полю prompt и из контекстного меню выберите Create → Constant для 
создания константы Выбрать имя файла; 

б)  Щелкните правой кнопкой мыши по полю function и выберите в контекстном меню пункт Create → Constant для соз-
дания константы. С помощью инструмента УПРАВЛЕНИЕ выберите пункт выпадающего меню open. 

 В палитре Functions → File I/O выберите функцию Read File. Эта функция читает количество байт данных с на-
чала файла, определяемое значением поля count. 

 В палитре Functions → File I/O выберите функцию Close File. Эта функция закроет файл. 

 В палитре Functions → Time& Dialog выберите подпрограмму Simple Error Handler VI. Этот ВП проверяет кла-
стер ошибок и, в случае появления ошибки, выводит на экран диалоговое окно. 

9.  Сохраните ВП под именем Чтение файла.vi. 
 

Запуск ВП 
 

10. Перейдите на лицевую панель и с помощью инструмента УПРАВЛЕНИЕ выберите кнопку Browse (обзор) в элемен-
те управления Путь к файлу. 

11. Выберите файл демофайл.txt и нажмите на кнопку Open или ОК. 



 

12. Запустите ВП. Строка, считанная из файла, отобразится на лицевой панели ВП. 
Задание  9.3. Создать ВП, согласно Вашему варианту 

 

№ 
варианта Содержание задания 

1 Создайте ВП, который генерирует двумерный массив случайных 
чисел размерностью 5 × 40 и записывает транспонируемый массив в 
файл текстового формата 

2 Создайте ВП, который записывает 3 произвольные строки в файл 
текстового формата. На ЛП должен отображаться путь к файлу 

3 
 

Создайте ВП, который генерирует двумерный массив случайных 
чисел размерностью 5 × 6, транспонирует его и записывает в файл 
формата электронной таблицы 

4 
 

Создайте ВП, который генерирует одномерный массив случайных 
чисел и записывает транспонируемый массив в файл любого форма-
та 

5 
 

Создайте ВП, который записывает массив чисел, содержащийся на 
ЛП, в файл. На ЛП должен отображаться путь к файлу 

6 
 

Создайте ВП, который генерирует двумерный массив случайных 
чисел размерностью 3 × 10 и записывает полученный массив в таб-
лицу на ЛП и в файл 

7 
 

Создайте ВП, который объединяет 2 строки (1 – Автоматизация из-
мерений, 2 – контроля и испытаний) в одну строку и записывает эту 
строку в файл. На ЛП должен отображаться путь к файлу 

8 
 

Создайте ВП, который генерирует два одномерных массива случай-
ных чисел, объединяет эти массивы в двумерный массив чисел и по-
мещает транспонированный массив в файл 

9 Создайте ВП, который записывает массив чисел в файл формата 
электронной таблицы. Файл должен содержать заголовки для каждо-
го столбца 

10 Создайте ВП, который объединяет два одномерных массива в одну 
строку и записывает ее в файл. На ЛП отображается путь к файлу 

11 Создайте ВП, который генерирует массив случайных чисел и запи-
сывает его в файл формата электронной таблицы. Файл должен со-
держать заголовки для каждого столбца 

12 Создайте ВП, который генерирует массив случайных чисел и запи-
сывает его в файл текстового формата. Файл должен содержать заго-
ловки каждого столбца 

13 Создайте ВП, который записывает 4 произвольные строки в файл 
текстового формата. На ЛП должен отображаться путь к файлу 

14 Создайте ВП, который объединяет два одномерных массива чисел в 
одну строку и записывает ее в файл. На ЛП отображается путь к 
файлу 

15 Создайте ВП, который генерирует массив случайных чисел и запи-
сывает его в файл текстового формата. Файл должен содержать заго-
ловки каждого столбца 

 
 
 

1. Каково назначение функций файлового ввода/вывода? Где они расположены? 
2. Назовите назначение функций файлового ввода/вывода высокого уровня. 
3. Назовите назначение функций файлового ввода/вывода низкого уровня. 
4. Для чего предназначены дополнительные функции работы с файлами? 
5. Для чего предназначена функция Format Into File? 
6. Какие существуют способы доступа к файлу при сохранении данных? 
7. Каким образом в LabVIEW осуществляется обработка ошибок при работе с функциями файлового ввода/вывода?  
8. Что представляет собой палитра функций файлового ввода/вывода? 
9. Как записать массив чисел в файл текстового формата, содержащий заголовки для каждого столбца? 

Контрольные вопросы 



 

3. РАБОТА С МОДУЛЯМИ СЕРИИ ADAM-4000. 
КОНТРОЛЬ ТЕМПЕРАТУРЫ, ВЛАЖНОСТИ,  

ЧИСЛА ОБОРОТОВ И СКОРОСТИ 
 

 
 

Занятие  № 10 
 

АВТОМАТИЗИРОВАННАЯ СИСТЕМА ИЗМЕРЕНИЯ,  
КОНТРОЛЯ И РЕГУЛИРОВАНИЯ ТЕМПЕРАТУРЫ 

 

Цель занятия: Ознакомиться с аппаратными и программными средствами системы измерения и регулирования темпе-
ратуры, построенной на основе модулей сбора данных ADAM серии 4000. 
 

ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 
 

Описание лабораторной установки. Лабораторный стенд (рис. 10.1), предназначенный для изучения системы измерения 
и регулирования температуры, включает в себя следующие элементы: 

1) блок питания модулей ADAM, усилителя и нагревателя;  
2) блок ввода-вывода данных ADAM-4011; 
3) конвертер интерфейса RS-485/422 в RS-232; 
4) термопару, объект исследования, усилитель выходного сигнала блока  ADAM-4011. 
Назначение блока 1 – питание конвертера, блока ввода-вывода ADAM-4011, усилителя и нагревателя. 

 
 

Рис. 10.1. Принципиальная схема лабораторного стенда 
Назначение блока 2 – измерение температуры объекта и регулирования этой температуры посредством включе-

ния/выключения лампочки. Данный блок имеет два дискретных выхода, один дискретный и один аналоговый вход, который 
позволяет получать сигнал напрямую с термопары (мВ) и преобразовывать его в значение температуры (°С). Блок подклю-
чается к системе через интерфейс  RS-485. 

Назначение конвертера 3 – связь контроллеров серии АДАМ 4000 с интерфейсами RS-485 с компьютерным интерфей-
сом RS-232. 

Управление объектом 4 осуществляется программой персонального компьютера, написанной на языке LabVIEW. 
Описание блока ввода-вывода данных ADAM-4011. Данный модуль (рис. 10.2) позволяет измерять температуру на-

прямую с J, K, T, E, R, S и B термопар и выдавать уже готовое значение температуры. Имеется еще один аналоговый вход, 
который позволяет оцифровывать напряжение в пределах ±15 мВ, ±50 мВ, ±100 мВ, ±500 мВ, ±1 В и ±2,5 В, а также ток в 
пределах ±20 мА (для этого необходим резистор номиналом 125 Ом). Данный модуль также имеет один дискретный вход, 
который может использоваться для контроля состояния какого-либо устройства, и два дискретных выхода, которые могут 
быть использованы для управления объектами контроля. 



 

 
 

Рис. 10.2. Модуль ввода данных с термопары ADAM-4011 
Алгоритм подключения модулей ADAM серии 4000 к 

персональному компьютеру 
 

Предварительная подготовка. Все модули ADAM должны быть подсоединены по интерфейсу RS-485 к блоку преоб-
разования интерфейсов  RS-485/RS-232.  

Если компьютер включен, то его необходимо выключить, иначе операционная система не сможет определить подклю-
ченное оборудование. 

Питание модулей тоже должно быть отключено. 
Подключение модулей. Преобразователь интерфейсов подключается к COM-порту системного блока при помощи ка-

беля с разъемами под интерфейс RS-232. 
Включается питание модулей и загружается компьютер. 
Предварительная настройка. Если модули подключены впервые, то необходимо произвести их конфигурацию. Кон-

фигурация осуществляется при помощи приложения Advantech devise manager. В приложении необходимо указать номер 
модуля и определить его номер внутри системы, а также произвести индивидуальную конфигурацию модуля. 

Если конфигурация ранее производилась, повторять операцию не имеет смысла. 
Работа с модулями. При помощи языка программирования (LabVIEW, Delphi, C++ и др.) производится обращение к 

Advantech devise manager с использованием инструментов, установленных вместе с драйверами ADAM.   
Описание графического пользовательского интерфейса. Окно программы управления стендом разбито на две пане-

ли (рис. 10.3). 
Правая панель служит для отображения динамики изменения температуры во времени посредством графика и трех 

цифровых индикаторов: текущего значения температуры, верхнего и нижнего пределов отклонения температуры от заданно-
го значения. 

Левая панель (панель регулятора) позволяет осуществлять настройку позиционного регулятора и содержит «ручку» на-
стройки задания регулятора и ползунок, устанавливающий величину гистерезиса регулятора, поле ввода значения допусти-
мого отклонения от задания. 

Описание кода программы. Блок-диаграмма состоит из четырех последовательно выполняющихся кадров: первые два 
кадра выполняют инициализацию и конфигурирование драйвера устройства, третий кадр содержит основной цикл програм-
мы (рис. 10.7), четвертый кадр закрывает драйвер устройства. 



 

 
 

Рис. 10.3. Окно программы управления стендом 
 

Блоки инициализации драйвера. Первый кадр (рис. 10.4) содержит функциональный блок, «открывающий» драйвер 
для устройства с указанным номером DevNum (этот номер присваивается конкретному модулю менеджером устройств Ad-
vantech), и возвращает указатель (DriverHandle), с помощью которого будет производиться дальнейшее обращение к модулю, 
и код ошибки (Driver error). 

 
Рис. 10.4. Открытие драйвера устройства 

 

 
 

Рис. 10.5. Конфигурирование драйвера 
 
Второй кадр (рис. 10.5) содержит функциональный блок конфигурирования драйвера. Данный 

блок через переменную Chan&Gain устанавливает канал для ввода аналогового сигнала и выбирает 
диапазон измерения. Переменная Chan&Gain представляет собой кластер (рис. 10.6), где Channel – номер 
канала для аналогового ввода, Gain – номер диапазона входного сигнала (для некоторых устройств не ука-
зывается). 

Третий кадр содержит основную исполняемую часть программы. В этом кадре (рис. 10.7) содер-
жатся стандартные функциональные блоки LabVIEW, за исключением двух функциональных блоков 
обращения к модулю ADAM-4011, и функциональный блок регулятора, реализующего двухпозицион-
ный закон регулирования. Функциональные блоки работы с модулем  ADAM-4011 описаны ниже. 

Блок ввода аналогового сигнала. Считывает текущее значение с канала аналогового ввода и 
возвращает значение напряжения с устройства, определенного переменной DriverHandle. 

 
 

Рис. 10.6. Кластер 
Chan&Gain 

Содержит ошибку, возникшую при обращении к драйверу 

Номер устройства в менеджере устройств  
(Device Manager) Advantech 

я 



 

 
 

 
 
 

DriverHandle – указатель на определенное устройство. 
Chan&Gain – кластер, содержащий информацию о номере канала и код диапазона измерения для некоторых устройств. 

 
 

Рис. 10.7. Основной цикл программы 
 
 
TrigMode – период опроса канала (0 – устанавливается программно в менеджере устройств, 1 – определяется внешним 

управляющим сигналом). 
error in – содержит код ошибки до выполнения этого блока. 
Voltage – возвращает значение напряжения (модуль ADAM-4011 способен возвращать сразу значение температуры).  
error out – возвращает код ошибки после выполнения этого блока. 
Блок вывода дискретного сигнала. Записывает бит данных в канал дискретного вывода устройства, определенного 

переменной DriverHandle. 
 

 
 

DriverHandle – указатель на определенное устройство. 
Port – номер порта дискретного вывода. 
BitPos – определяет позицию бита порта. 
State – значение бита записываемого в порт. 
error in – содержит код ошибки до выполнения этого блока. 
error out – возвращает код ошибки посте выполнения этого блока. 

 

 
 

Переменная – текущее значение регулируемой величины. 
Задание – устанавливает задание регулятора. 
Гистерезис – устанавливает величину гистерезиса закона регулирования. 
Выход, если выше задания – задает выходное значение в случае, если переменная превышает задание. 
Выход, если ниже задания – задает выходное значение в случае, если переменная ниже задания. 

 
 
 

1) Подключить лабораторный стенд к com-порту компьютера. 
2) Включить питание стенда. 
3) Включить компьютер и открыть программу управления лабораторным стендом. 

 

Блок позиционного регулятора. Реализует функцию двухпозиционного закона регулирования. 

Порядок выполнения работы 

, 
, 



 

4) Изучить пользовательский интерфейс программы и ее работу, изменяя настройку и задание регулятора (рекоменду-
ется взять 3-4 различных значения гистерезиса). 

5) Сделать вывод о влиянии величины гистерезиса на качество регулирования температуры лампочки. 
6) Во второй части работы ознакомиться с кодом программы управления лабораторным стендом, который можно от-

крыть с помощью верхнего меню (Window → Show block diagram) или нажатием Ctrl + E. 
7) Видоизменить программу в соответствии с выданным вариантом. 
8) Закрыть виртуальный прибор, не сохраняя изменения. 

 

№  
варианта Задание 

1, 3, 6, 11 Добавить показывающий прибор (термометр, progress bar, 
стрелочный прибор) для отображения текущей температу-
ры лампы. Свойства прибора уточнить у преподавателя 

2, 7, 12, 13 Добавить индикатор, сигнализирующий о выходе темпера-
туры объекта за заданные пределы 

4, 9, 14 Добавить индикатор текущего состояния выхода регулятора 
5, 8, 10, 15 Изменить дизайн графического интерфейса программы 

Контрольные вопросы 
 

1. Расскажите об устройстве лабораторной установки. 
2. Как в эксперименте определяется температура объекта исследования? 
3. Объясните схему лабораторного стенда. 
4. Для чего предназначен модуль ADAM-4011? 
5. При помощи чего ADAM-4011 подключается к ПК? 
6. Какой закон регулирования используется в системе? 
7. При помощи чего осуществляется закон регулирования? 
8. Поясните порядок выполнения работы. 
9. Почему необходимо сначала подключить установку к компьютеру, а лишь затем включать ПК? 

 
Занятие  № 11 

 
АВТОМАТИЗИРОВАННАЯ СИСТЕМА ИЗМЕРЕНИЯ И  

КОНТРОЛЯ СКОРОСТИ ПОТОКА ВОЗДУХА 
 

Цель занятия: Ознакомиться с аппаратными и программными средствами системы измерения и контроля скорости по-
тока воздуха, построенной на основе модулей сбора данных ADAM серии 4000. 
 
 

ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 
 

Описание лабораторной установки. Лабораторный стенд (рис. 11.1), предназначенный для изучения системы измерения 
и контроля скорости потока воздуха, включает в себя следующие элементы: 

1) блок питания; 
2) блок ввода-вывода данных ADAM-4080D; 
3) конвертер интерфейса RS-485/422 в RS-232; 
4) вентилятор, преобразователь скорости воздушного потока АП1-2.  
Назначение блока 1 – питание конвертера, блока ввода-вывода ADAM-4080D, вентилятора и преобразователя. 
Назначение блока 2 – подсчет количества импульсов, поступивших на дискретный вход. Данный блок имеет два дис-

кретных входа и два дискретных выхода, реле с нормально разомкнутыми контактами. Блок позволяет подсчитывать им-
пульсы, поступающие с первичного преобразователя, частота которых пропорциональна скорости воздушного потока. 

Блок подключается к системе через интерфейс  RS-485. 
Управление объектом 4 осуществляется программой персонального компьютера, написанной на языке LabVIEW. 



 

 
Рис. 11.1. Принципиальная схема лабораторного стенда 

 
Описание блока ввода-вывода данных ADAM-4080D. Данный модуль, ADAM-4080D (рис. 11.2), позволяет опреде-

лять количество импульсов, поступивших на дискретный вход блока. Модуль имеет два канала дискретного ввода с индика-
цией и два дискретных выхода, реле с нормально разомкнутыми контактами. Входная частота счетчика 5 Гц – 50 кГц. Имеется 
сторожевой таймер. Напряжение (логический 0) 0 – 1 В (изолированный ввод), 0 – 5 В (неизолированный ввод), напряжение 
(логический 1) 3,5 – 30 В (изолированный ввод), 0 – 5 В (неизолированный ввод). Сегментированный индикатор частоты на 
диодах программируется на работу с первым или вторым каналом. 

 

 
 

Рис. 11.2.  Блок ввода-вывода данных ADAM-4080D 
Описание графического пользовательского интерфейса. Окно программы управления стендом показано на рис. 11.3. 
В левой части панели задаются настройки сигнализации, верхняя и нижняя предупредительные границы, верхняя и ниж-

няя аварийные  границы. 
Правая часть виртуальной панели служит для отображения динамики изменения скорости ветра во времени посредст-

вом графика и  цифровых индикаторов. 
Описание кода программы. Блок-диаграмма состоит из четырех последовательно выполняющихся кадров: первые два 

кадра выполняют инициализацию и конфигурирование драйвера устройства, третий кадр содержит основной цикл программы, 
четвертый кадр закрывает драйвер устройства. 

Первый кадр (рис. 11.4) содержит функциональный блок, «открывающий» драйвер для устройства с указанным номе-
ром DevNum (этот номер присваивается конкретному модулю менеджером устройств Advantech), и возвращает указатель 
(DriverHandle), с помощью которого будет производиться дальнейшее обращение к модулю, и код ошибки (Driver error). 

 



 

 
 

Рис. 11.3. Окно программы управления стендом 

 
 

Рис. 11.4. Открытие драйвера устройства 
 

 
 

Рис. 11.5. Конфигурирование драйвера 
 
Второй кадр (рис. 11.5) содержит функциональный блок конфигурирования драйвера. Данный блок через переменную 

Chan&Gain устанавливает канал для ввода аналогового сигнала и выбирает диапазон измерения. Третий кадр содержит ос-
новную исполняемую часть программы. В этом кадре (рис. 11.6) содержатся стандартные функциональные блоки LabVIEW,  
за исключением двух функциональных блоков обращения к модулю ADAM-4080D. 

 

 
 

 

Блок ввода аналогового сигнала. Считывает текущее значение с канала аналогового ввода и возвращает значение на-
пряжения с устройства, определенного переменной DriverHandle. 



 

 
 

Рис. 11.6. Основной цикл программы 
 

DriverHandle – указатель на определенное устройство. 
Chan&Gain – кластер, содержащий информацию о номере канала и код диапазона измерения дла некоторых устройств. 
TrigMode – период опроса канала (0 – устанавливается программно в менеджере устройств, 1 – определяется внешним 

управляющим сигналом). 
error in – содержит код ошибки до выполнения этого блока; 
Voltage – возвращает значение напряжения.  
error out – возвращает код ошибки после выполнения этого блока. 
 

 

 
1)  Подключить лабораторный стенд к com-порту компьютера. 
2)  Включить питание стенда. 
3)  Включить компьютер и открыть программу управления лабораторным стендом. 
4)  Изучить пользовательский интерфейс программы и ее работу.  
5)  Ознакомиться с кодом программы управления лабораторным стендом, который можно открыть с помощью верхнего 

меню (Window → Show block diagram) или нажатием Ctrl + E. 
6)  Изменить свойства одного управляющего элемента на лицевой панели по собственному усмотрению и одного по 

указанию преподавателя. 
7)  Закрыть виртуальный прибор, не сохраняя изменения. 
8)  Сделать необходимые выводы о проделанной работе. 

 
Контрольные вопросы 

 

1. Расскажите об устройстве лабораторной установки. 
2. Как в эксперименте определяется скорость воздушного потока? 
3. Объясните схему лабораторного стенда. 
4. Для чего предназначен модуль ADAM-4080D? 
5. Какие инструменты используются для индикации измеренных величин? 
6. Поясните порядок выполнения работы. 
7. Почему необходимо сначала подключить установку к компьютеру, а лишь затем включать ПК? 
8. Какие интерфейсы поддерживают модули ADAM?  

 
Занятие  № 12 

 

АВТОМАТИЗИРОВАННАЯ СИСТЕМА ИЗМЕРЕНИЯ И  
КОНТРОЛЯ ВЛАЖНОСТИ ВОЗДУХА 

 

Цель занятия: Ознакомиться с аппаратными и программными средствами системы измерения и контроля влажности 
воздуха, построенной на основе модулей сбора данных ADAM серии 4000. 

 

ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 
 

Описание лабораторной установки. Лабораторный стенд (рис. 12.1), предназначенный для изучения системы измерения 
и контроля влажности воздуха, включает в себя следующие элементы: 

Порядок выполнения работы 



 

1) блок питания; 
2) блок ввода-вывода данных ADAM-4018; 
3) конвертер интерфейса RS-485/422 в RS-232; 
4) две термопары (для измерения температуры сухого и влажного термометров), вентилятор. 
Система предназначена для измерения влажности воздуха в аудитории. 
Назначение блока 1 – питание конвертера, блока ввода-вывода ADAM-4018 и объекта исследования. 
Назначение блока 2 – измерение сигналов сухой и влажной термопар. Данный блок имеет 8 аналоговых входов, каждый 

из которых позволяет получать сигнал напрямую с термопары (мВ) и преобразовывать его в значение температуры (°С). 
Блок подключается к системе через интерфейс  RS-485. 

 
Рис. 12.1. Принципиальная схема лабораторного стенда 

 

Управление объектом 4 осуществляется программой персонального компьютера, написанной на языке LabVIEW. 
Описание блока ввода-вывода данных ADAM-4018. Данный модуль (рис. 12.2) позволяет измерять температуру на-

прямую с J, K, T, E, R, S и B термопар и выдавать уже готовое значение температуры. Имеются  
8 аналоговых входов, которые позволяют оцифровывать напряжение в пределах ±15 мВ, ±50 мВ, ±100 мВ, ±500 мВ, ±1 В и 
±2,В, а также ток в пределах ±20 мА (для этого необходим резистор номиналом 125 Ом).  

 
Рис. 12.2. 8-канальный модуль ввода данных с термопар ADAM-4018 

 
 



 

Рис. 12.3. Окно программы управления стендом 
 
Описание графического пользовательского интерфейса. Окно программы управления стендом показано на рис. 12.3. 
Описание кода программы. Блок-диаграмма состоит из четырех последовательно выполняющихся кадров: первые два 

кадра выполняют инициализацию и конфигурирование драйвера устройства, третий кадр содержит основной цикл програм-
мы (рис. 12.6), четвертый кадр закрывает драйвер устройства. 

Первый кадр (рис. 12.4) содержит функциональный блок, «открывающий» драйвер для устройства с указанным номером 
DevNum (этот номер присваивается конкретному модулю менеджером устройств Advantech), и возвращает указатель (DriverHan-
dle), с помощью которого будет производиться дальнейшее обращение к модулю, и код ошибки (Driver error). 

 

 
Рис. 12.4. Открытие драйвера устройства 

 
Рис. 12.5. Конфигурирование драйвера 

 
 
 

 
 
 

DriverHandle – указатель на определенное устройство. 
Chan&Gain – кластер, содержащий информацию о номере канала и код диапазона измерения дла некоторых устройств. 
TrigMode – период опроса канала (0 – устанавливается программно в менеджере устройств, 1 – определяется внешним 

управляющим сигналом) 
error in – содержит код ошибки до выполнения этого блока. 
Voltage – возвращает значение напряжения (модуль ADAM-4011 способен возвращать сразу значение температуры).  
error out – возвращает код ошибки после выполнения этого блока. 
Блок вывода дискретного сигнала. Записывает бит данных в канал дискретного вывода устройства определенного 

переменной DriverHandle. 
 

 
 

DriverHandle – указатель на определенное устройство. 
Port – номер порта дискретного вывода. 
BitPos – определяет позицию бита порта. 
State – значение бита записываемого в порт. 
error in – содержит код ошибки до выполнения этого блока. 
error out – возвращает код ошибки после выполнения этого блока. 



 

 
 

Скорость потока воздуха  влияет на температуру мокрого термометра и учитывается через психрометрический коэффи-
циент А. Относительная влажность воздуха рассчитывается по формуле: 

 

Влажность = ((P(tм) – A (tс – tм))/P(tс), 
 

где А – психрометрический коэффициент, определяется из таблицы: 
 

Скорость ветра, м/с А, К–1 

> 2,5 0,000656 
0,5 – 2 0,0008 
< 0,5 0,0012 

 

Таблица для определения  парциального давление пара в воздухе P(t) приведена ниже: 
 

t P(t) 

–20 0,001027 
–10 0,0026 
0 0,006107 

10 0,012271 
20 0,023368 
30 0,042417 
40 0,073749 
60 0,19919 
80 0,47359 
100 1,01325 

 
 

Рис. 12.6. Основной цикл программы 
 

 
 
 

1. Подключить лабораторный стенд к com-порту компьютера. 
2. Включить питание стенда. 

Блок определения влажности по разности температур термометров. Блок реализует функцию определения влаж-
ности воздуха в аудитории. 

Блок ввода аналогового сигнала. Считывает текущее значение с канала аналогового ввода и возвращает зна-
чение напряжения с устройства, определенного переменной DriverHandle. 

Порядок выполнения работы 



 

3. Включить компьютер и открыть программу управления лабораторным стендом. 
4. Изучить пользовательский интерфейс программы и ее работу.  
5. Сравнить температуры влажного термометра при включенном и при выключенном вентиляторе. 
6. По полученным показаниям температур сухого и влажного термометров при включенном вентиляторе  определить 

влажность воздуха. 
7. Во второй части работы ознакомиться с кодом программы управления лабораторным стендом, который можно от-

крыть с помощью верхнего меню (Window → Show block diagram) или нажатием Ctrl + E. 
8. Изменить свойства одного управляющего элемента на лицевой панели по собственному усмотрению и одного по указа-

нию преподавателя. 
9. Закрыть виртуальный прибор, не сохраняя изменения. 
10. Сделать необходимые выводы о проделанной работе. 

Контрольные вопросы 
 

1. Расскажите об устройстве лабораторной установки. 
2. Как в эксперименте определяется влажность воздуха? 
3. Объясните схему лабораторного стенда. 
4. Для чего предназначен модуль ADAM-4018? 
5. Какие инструменты используются для индикации измеренных величин? 
6. Поясните порядок выполнения работы? 
7. Почему необходимо сначала подключить установку к компьютеру, а лишь затем включать ПК? 
8. Для чего необходим преобразователь интерфейсов? 

 



 

4. ИЗМЕРЕНИЯ, КОНТРОЛЬ И ИСПЫТАНИЯ СВОЙСТВ  
МАТЕРИАЛОВ НА УДАЛЕННЫХ ОБЪЕКТАХ  

АВТОМАТИЗАЦИИ С ИСПОЛЬЗОВАНИЕМ ИНТЕРНЕТА 
 

 
 

Занятие  № 13 
 

ИЗУЧЕНИЕ МЕТОДА МГНОВЕННОГО ИСТОЧНИКА ТЕПЛА И УСТРОЙСТВА ДЛЯ ИЗМЕРЕНИЯ ТЕПЛОФИЗИЧЕ-
СКИХ СВОЙСТВ ТВЕРДЫХ МАТЕРИАЛОВ 

 

Цель занятия: Изучить теоретические основы метода мгновенного источника тепла, а также устройство автоматизиро-
ванного лабораторного стенда. 

Задание: Определить теплофизические характеристики полиметилметакрилата.  
 

Теоретические указания 
 

Объектом измерения в лабораторной работе являются теплофизические характеристики  образца из полиметилметакри-
лата. В образце находится линейный источник тепла (нагреватель), а на расстоянии R от него расположена обмотка из очень 
тонкой медной проволоки диаметром 0,05 мм, выполняющая функции термопреобразователя сопротивления. 

Если в нагревателе мгновенно выделяется количество тепла Qл, то температурное поле в образце на расстоянии r от ис-
точника тепла в  любой момент времени τ будет описываться следующей математической моделью: 
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где с, ρ и λ – удельная теплоемкость, плотность и теплопроводность исследуемого материала; T – температура; τ – время; 
δ(τ), δ(r) – дельта-функции Дирака.  

Решение дифференциального уравнения имеет вид: 
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График этой функции при фиксированном значении r и заданных значениях теплопроводности λ и температуропровод-
ности a имеет вид, представленный на рис. 13.1. Координаты экстремума Tmax, τmax данной функции зависят от теплопровод-
ности и температуропроводности исследуемого материала. Для определения этих координат найдем производную функции 
T(r, τ) и приравняем ее к нулю: 
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Анализируя полученную формулу, приходим к выводу, что  производная функции температурного поля по времени 

может быть равна нулю, когда ∞=τ  или когда 
a

r
4

2
=τ . Очевидно, что во втором случае будет максимальное значение 

температуры. Таким образом, определив в эксперименте момент времени τmax, когда наблюдается максимальное зна-
чение температуры в точке образца с известной координатой R, можно рассчитать значение коэффициента темпе-
ратуропроводности  
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Рис. 13.1 

Теплопроводность при этом рассчитывается по формуле: 
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Так как длительность теплового импульса в реальности отличается от нуля, то в расчетные формулы 13.2 и 13.3 необ-

ходимо ввести поправочные функции. В итоге получим следующие зависимости:  
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Значения поправочных функций приведены в табл. 13.1  

13.1. Значения поправочных функций 

 

τ0/τMAX ϕA ϕλ τ0/τMAX ϕ A ϕλ 

0,01 0,01 0,0037 0,09 0,0944 0,0347 

0,02 0,0202 0,0074 0,10 0,1055 0,0389 

0,03 0,0305 0,0113 0,11 0,1167 0,0429 

0,04 0,0408 0,015 0,12 0,1280 0,0471 

0,05 0,0834 0,0188 0,13 0,1395 0,0513 

0,06 0,0619 0,0228 0,14 0,1511 0,0556 

0,07 0,0727 0,0267 0,15 0,1629 0,0599 

0,08 0,0834 0,0307 0,16 0,1748 0,0642 

 

ττmax

Тmax 

Т(r, τ) 



 

Описание лабораторной установки 
 

 
 

Функциональная схема лабораторной установки изображена на рис. 13.2. Линейный источник тепла размещен в образце 
из полиметилметакрилата. Размеры образца позволяют считать его в первом приближении бесконечным (в тепловом смыс-
ле) телом. Сопротивление нагревателя равно 3,5 Ом, последовательно с ним включен балластный резистор (для ограничения 
тока), имеющий сопротивление Rбал = 6 Ом. Через нормально разомкнутый контакт реле K нагреватель подключен к  блоку 
питания. На расстоянии r = 5 мм от нагревателя размещена обмотка из медной проволоки, выполняющей функцию термо-
преобразователя сопротивления. Обмотка включена в мостовую измерительную схему, в одно из плеч которой включен ма-
газин сопротивлений, позволяющий производить коррекцию напряжения разбаланса моста при изменении температуры ок-
ружающей среды. Это напряжение через  

 
 

Рис. 13.2. Функциональная схема лабораторного стенда 

 
усилитель постоянного тока поступает на аналоговый вход платы сбора данных PCI-911DG фирмы ADLINK. Таким образом, 
в процессор персонального компьютера  поступает цифровой эквивалент температуры T(R, τ) образца. Для обработки изме-
рительного сигнала и формирования дискретного выходного сигнала на катушку реле K разработана программа  на графиче-
ском языке LabVIEW. Кроме управления лабораторным стендом и обработки экспериментальных данных, программа позво-
ляет регистрировать и выводить на экран монитора в табличном виде зависимость T(R, τ).  Определив по этой зависимости 
максимальное значение температуры и соответствующее ему значение времени, можно рассчитать теплофизические харак-
теристики исследуемого образца по формулам 13.2 – 13.4. 

Порядок проведения эксперимента 
 

1. Измерить длину l нагревателя.  
2. Измерить расстояние R от нагревателя до термопреобразователя сопротивления. 
3. Измерить сопротивление Rнагр линейного нагревателя. 
4. Установить напряжение U = 12 В на блоке питания. 
5. Рассчитать удельную мощность нагревателя.  
6. Включить персональный компьютер. 
7. Загрузить среду программирования LabVIEW. 
8. Открыть в LabVIEW файл виртуального прибора VI, позволяющего управлять лабораторным стендом (Имя файла и 

его расположение уточнить у преподавателя). 
9. Изучить блок-диаграмму виртуального прибора. 
10. Запустить выполнение программы. 
11. Установить на задатчике продолжительность теплового импульса, значение которой укажет преподаватель. 
12. При установившемся сигнале термопреобразователя включить реле K (путем нажатия соответствующей кнопки на 

панели управления). При этом контакт реле на заданное время подключит нагреватель к блоку питания. 



 

13. Наблюдать изменение сигнала термопреобразователя (температуры). Когда температура достигнет максимума и 
станет уменьшаться, остановить эксперимент. 

14.   По таблице определить значения τmax и Tmax, учитывая, что за нуль принимается начальная температура в образце.  
14. Определить по табл. 13.1 значения поправочных функций ϕа, ϕλ . 
15. Рассчитать с использованием формул (13.4) температуропроводность и теплопроводность полиметилметакрилата. 
16. Пункты 11 – 16 повторить 3 раза. 
17. Экспериментальные и расчетные данные занести в таблицу. 
18. Определить среднее значение теплопроводности и температуропроводности и доверительный интервал при довери-

тельной вероятности 0,95. 
 
 

Содержание отчета 
 

1. Название работы, цель, задание. 
2. Расчетные формулы с пояснениями. 
3. Схема лабораторного стенда. 
4. Таблица 13.2 с экспериментальными данными и результатами расчетов. 
5. Выводы. 

13.2. Экспериментальные данные 
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Контрольные вопросы 

 

1. Записать математическую модель температурного поля в образце. 
2. Пояснить смысл граничных условий в математической модели. 
3. Какие особенности образца не учитывает математическая модель температурного поля? 
4. Вывести расчетные зависимости 13.2 – 13.4. 
5. Для чего в расчетные зависимости вводятся поправки? 
6. Объяснить устройство термопреобразователя сопротивления. 
7. Объяснить устройство экспериментальной установки. 
8. Какую функцию выполняет плата сбора данных? 
9. Объяснить порядок проведения эксперимента. 
10. Как изменится значение Tmax при увеличении или уменьшении теплопроводности образца? 
11. Как изменится значение τmax при увеличении или уменьшении температуропроводности образца?  

 
Занятие  № 14 

 

ОПРЕДЕЛЕНИЕ ТЕПЛОПРОВОДНОСТИ  
ТВЕРДЫХ НЕМЕТАЛЛИЧЕСКИХ МАТЕРИАЛОВ  

СТАЦИОНАРНЫМ МЕТОДОМ 
 

Цель занятия: Изучение стационарного метода и измерительного устройства для определения теплопроводности неме-
таллических материалов  стационарным методом. 

 

Задание:  
1.  Изучить теоретические основы стационарного метода определения теплопроводности  твердых материалов. 
2.  Изучить конструкцию прибора ИТ-4 и схему лабораторного стенда. 
3.  Экспериментально определить теплопроводность полиметилметакрилата стационарным методом. 

 
ТЕОРЕТИЧЕСКИЕ УКАЗАНИЯ 

 

Если твердое тело нагревается или охлаждается, то внутри него наблюдается неравномерное распределение температу-
ры, что приводит к перемещению тепла из одних точек тела в другие. В этом случае тепловой поток будет направлен из уча-
стков тела с большей температурой к участкам с меньшей температурой. Для характеристики теплового потока введено по-
нятие плотности потока q

r
. 

Плотностью теплового потока q
r

 называется  величина, по модулю равная количеству тепла, проходящего в единицу 
времени через единицу площади изотермической поверхности в направлении нормали.  



 

Предел отношения разности температур ∆Т двух близких изотермических поверхностей с температурами Т и Т + ∆Т к 
расстоянию по нормали между ними называют температурным градиентом. Это векторная величина, численно равная из-
менению температуры на единицу длины нормали (внешней) к изотермической поверхности и направленная в сторону воз-
растания температуры, т.е. в сторону, противоположную тепловому потоку. Температурный градиент является мерой интен-
сивности изменения температуры в данном направлении. 

 

Положив в основу предположение о наличии линейной зависимости между тепловым потоком и температурным гради-
ентом, Фурье получил закон теплопроводности, согласно которому плотность теплового потока пропорциональна темпера-
турному градиенту: 

Tq gradλ−= .                                       (14.1) 

Знак «минус» в уравнении показывает, что плотность потока q
r

 и температурный градиент имеют противоположное на-
правление, или в направлении потока тепла температура уменьшается. Коэффициент пропорциональности λ  назван коэф-
фициентом теплопроводности (теплопроводностью). 

В лабораторной работе значение λ  будет определяться стационарным методом при одномерном тепломассопереносе в 
исследуемом теле. Измерительная схема метода представлена на рис. 14.1. 
 
 
 
 
 
 
 
 

Рис. 14.1. Измерительная схема метода определения теплопроводности 
 

В исследуемом теле, выполненном в форме пластины, организуют теплоперенос в направлении вектора теплового по-
тока q

r
. В стационарных условиях для данной измерительной  схемы уравнение (14.1) примет вид: 

h
TTq 21 −λ= .                                         (14.2) 

Измеряя плотность теплового потока q
r

, пронизывающего образец испытываемого материала, температуры  T1 и T2 на 
противоположных поверхностях исследуемого тела и толщину образца h, теплопроводность определяют по выражению: 
 

21 TT
qh
−

=λ .                                       (14.3) 

 

Конструкция прибора ИТ-4. Прибор ИТ-4, конструктивная схема которого представлена на рис. 14.2, содержит сле-
дующие основные сборочные единицы и детали: 1 – основание; 2 – холодильник; 3 – нагреватель; 4 – кронштейн; 5 – экран; 
6 – ползун; 7 – обойму; 8 – измеритель толщины образца; 9 – диск; 10 – крышку; 11 – кольцо; 12 – втулку; 13 – преобразова-
тель температуры; 14 – колпак; 15 – плату; 16 – исследуемый образец; 17 – преобразователь теплового потока. 

Основание 1 прибора, представляющее собой сварную стальную конструкцию прямоугольной формы, предназначено 
для крепления к нему кронштейна 4, холодильника 2 и дна с опорными ножками прибора. Внутри основания укреплена пла-
та 15, разведены и укреплены электрические провода, схема и шланги охлаждения.  

Холодильник 2 представляет собой полый диск, внутри которого циркулирует теплоноситель (вода) с постоянной тем-
пературой. Он предназначен для отвода тепла, пронизывающего испытуемый образец 16, и поддержания температуры ниж-
ней поверхности образца на постоянном уровне во время испытаний.  

В центре рабочей поверхности холодильника, внутри монолитного электроизоляционного покрытия, укреплены чувстви-
тельный элемент 17 преобразователя теплового потока. Покрытие предназначено для защиты преобразователя теплового по-
тока от механических повреждений. Проводники от чувствительного элемента уложены в специальных каналах, устроенных 
в корпусе холодильника, и выведены через полость кронштейна 4 на его крышку. 

Нагреватель 3 предназначен для нагревания верхней поверхности образца 16. Он состоит из массивного медного корпу-
са, внутри которого смонтирован нагревательный элемент, обеспечивающий получение тепловых потоков плотностью q

r
 до 

104 Вт/м2. 
Кронштейн 4 предназначен для крепления к основанию 1 обоймы 7. Он насажен на основание на центрирующих штифтах 

и крепится к нему четырьмя винтами.  
Обойма 7 предназначена для размещения в ней ползуна 6, крепления измерителя толщины 8, диска 9 и колпака 14. 

Обойма представляет собой трубу с двумя фланцами, один из которых служит для крепления обоймы к кронштейну, другой 
– для крепления диска 9. По концам обоймы внутри нее запрессованы подшипники скольжения ползуна. 

 

h

Т1 

Т2 

q 



 

 
 

Рис. 14.2. Конструкция прибора ИТ-4 
Экран (тепловой) 5, как и холодильник, представляет собой полый диск с циркулирующей внутри водопроводной во-

дой. Он предназначен для защиты (экранирования) от перегрева деталей прибора, расположенных выше нагревателя, кре-
пится неподвижно с помощью винтов к верхней крышке нагревателя через электротеплоизоляторы. 

В центре верхней части корпуса экрана приварен стержень – ползун 6 и ввинчены два штуцера для подачи и отвода 
циркулирующего хладагента. 

Преобразователи температуры 13 предназначены для измерения температуры в центрах обеих поверхностей образца и 
разности этих температур. 

Каждый преобразователь температуры представляет собой ленточную термопару, помещенную в эластичную обкладку, 
приклеенную к рабочей поверхности нагревателя или холодильника. 

Измеритель толщины 8  предназначен для измерения толщины образца. Он крепится неподвижно в специально преду-
смотренном отверстии на конце кронштейна 4 с помощью зажимного винта, будучи предварительно выставленным следую-
щим образом: при отсутствии зазора между холодильником и нагревателем (с наклеенными на их рабочие поверхности пре-
образователями температуры 13) нижний конец подвижного штока измерителя толщины должен касаться верхней плоскости 
экрана 5. При этом показания на шкале измерителя должны быть равны нулю. 

Колпак 14  предназначен для ограждения нагревателя с экраном и кронштейна с измерителем толщины; он представля-
ет собой стальной цилиндр с приваренным изнутри кольцом, к которому крепится диск 9; с помощью последнего колпак 14 
неподвижно крепится к верхнему фланцу обоймы 7. 

Кольцо 11 через круглое отверстие в колпаке 14 надевается на измеритель толщины 8 и фиксируется на нем с помощью 
винта. 

В рабочем состоянии прибора между холодильником 2 и нагревателем 3 зажат испытуемый образец 16, помещенный 
между эластичными обкладками преобразователей температуры 13. Зазор для образца между обкладками образуется при 
помощи механизма вертикального перемещения нагревателя в пределах от 0 до 100 мм. Этот механизм состоит из крышки 
10, связанной резьбой с ползуном 6, перемещающейся внутри обоймы 7. 

При вращении крышки 10 нагреватель перемещается в вертикальном направлении параллельно поверхности холодиль-
ника. В зазор между холодильником и нагревателем помещают образец и вращением крышки 10 в обратном направлении 
опускают нагреватель на образец без зазора. 

После соприкосновения нагревателя с верхней поверхностью образца при одновременном образования зазора между 
крышкой 10 и диском 9, на что укажет остановка стрелки измерителя толщины 8, масса подвижной системы прибора оказы-
вает на образец постоянное удельное давление 5⋅103 Н/м2. 

Образец из материала изготавливается в виде диска, торцовые поверхности которого должны быть плоскопараллель-
ными с отклонением от плоскопараллельности не более ± 0,005 мм для образцов толщиной 0,5 мм и не менее ± 0,02 мм для 
образцов толщиной 10 мм. Не допускаются к исследованиям образцы с вогнутостью хотя бы одной из поверхностей. Реко-
мендуемые размеры образца приведены в табл. 14.1. 



 

 
 

Таблица 14.1 
 

Рекомендуемые размеры, мм Ориентировочное значение 
теплопроводности,  

Вт/(м ⋅ К) Диаметр Толщина 

от 0,01 до 0,1 
от 0,1 до 1,0 
от 1,0 до 1,5 
от 1,5 до 2,5 
от 2,5 до 5,0 

от 60 до 120 
от 60 до 120 
от 100 до 120 

100 
100 

от 0,5 до 5 
от 1 до 5 
от 3 до 8 
от 5 до 10 
от 8 до 10 

   

Температурный режим измерений определяется мощностью, подводимой к нагревателю, и температурой хладагента, 
циркулирующего между холодильником и термостатом. 

Для каждого режима измерений необходимо соблюдать условие: разность температур торцовых поверхность образца не 
должна превышать 5 К. Для измерения плотности теплового потока, пронизывающего испытуемый образец, служит термо-
электрический преобразователь теплового потока 17, установленный в монолитном покрытии  холодильника. 

Преобразователь имеет вид плоской пластины 1 (рис. 14.3) из эпоксидного компаунда, внутри которой размещены про-
водники дифференциальных термопар 2. Горячие и холодные спаи термопар находятся соответственно на нижней и верхней 
гранях пластины. Поэтому термоЭДС термопар пропорциональна разности температур граней (градиенту температур), а 
значит, и тепловому потоку (при известной теплопроводности пластины). 

Внутри такой пластины толщиной 1 мм и диаметром 50 мм может размещаться до 2000 дифференциальных термопар, 
что обеспечивает высокую чувствительность преобразователя. 

 
 
 
 
 
 
 
 

Рис. 14.3. Конструкция преобразователя теплового потока 
Описание лабораторной установки 

Лабораторная установка включает в себя (рис. 14.4): 
• измеритель теплопроводности ИТ-4; 
• жидкостный термостат, обеспечивающий циркуляцию воды с постоянной температурой через холодильник и экран 

измерителя ИТ-4; 
• клеммник (коннектор), к которому подключены два термоэлектрических преобразователя (ТЭП) измерителя ИТ-4, 

ТЭП жидкостного термостата и преобразователь теплового потока (тепломер); 
 

 
 

Рис. 14.4. Измерительная установка для определения  
теплопроводности материалов 

 

q

ЭДС тепломера 

1 

2



 

 

Рис. 14.5. Структурная схема канала измерения аналоговых  
входных сигналов в плате сбора данных 

 
• персональный компьютер, оснащенный платой АЦП/ЦАП (платой сбора данных), на АЦП которой с коннектора по-

ступают сигналы преобразователей; 
• усилитель мощности сигнала ЦАП платы сбора данных, необходимый для питания электронагревателя прибора ИТ-

4. 
Плата сбора данных типа PCI-1202Н фирмы ISP DAS (Тайвань) способна принимать сигналы от 32 датчиков с аналого-

вым выходом (–10…+10) В и 16 датчиков с дискретным выходом (напряжения уровней, соответствующих логическому ну-
лю или единице), а также формировать дискретные выходные сигналы по 16 каналам и аналоговые сигналы по двум кана-
лам. 

Программное обеспечение, выполняющее функции обработки поступающей от преобразователей информации  и 
управления мощностью нагревателя, выполнено в среде разработки виртуальных инструментов LabVIEW. При измерении 
сигналов преобразователей с помощью платы сбора данных аналоговый мультиплексор подключает к усилителю поочеред-
но один из входных сигналов (рис. 14.5):  

Е1 – ЭДС термоэлектрического преобразователя термостата; 
E2 – ЭДС преобразователя теплового потока; 
Е3 – ЭДС термоэлектрического преобразователя на верхней грани образца; 
Е4 – ЭДС термоэлектрического преобразователя на нижней грани образца.  
С помощью АЦП получают цифровые эквиваленты входных сигналов. В течение короткого промежутка времени изме-

ряется n мгновенных значений сигнала с частотой 100 кГц, и результаты измерений помещаются в памяти буфера данных и 
образуют выборку из n цифровых эквивалентов входной величины. Далее в программе из каждой выборки определяется 
среднее значение и среднее квадратичное отклонение σ. 

Случайная составляющая относительной погрешности косвенного измерения теплопроводности  вычисляется по сле-
дующей формуле: 
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где σq, σh, ,
1Тσ  

2Тσ  – соответственно средние квадратические отклонения результатов измерения плотности теплового по-

тока, толщины образца, температур на верхней и на нижней гранях образца; k – коэффициент, который при большом объеме 
выборки  зависит от выбранной доверительной вероятности.  

Программа управления лабораторным стендом, обработки экспериментальных данных, их визуализации разработана в 
LabVIEW, а лицевая панель виртуального прибора представлена на рис. 14.6. 
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Рис. 14.6. Вид панели управления лабораторным стендом 
Порядок выполнения работы 

 

1. Включить лабораторную установку, персональный компьютер. Запустить программу управления лабораторным 
стендом (cовместно с преподавателем). 

2. Установить напряжение питания нагревателя прибора ИТ-4 15 В. 
3. При помощи крышки 10 прибора ИТ-4 опустить нагреватель 3 (см. рис. 14.2) на нагреватель 2 и вращением кольца 

11 установить нулевые показания микрометра. 
4. Поднять нагреватель 3 и поместить под него образец испытуемого материала. 
5. Опустить нагреватель на образец (когда нагреватель будет соприкасаться с поверхностью образца, стрелка микро-

метра перестанет перемещаться). После чего сделать еще 2-3 оборота крышки для создания давления на образец. 
6. На виртуальной панели управления компьютера при помощи соответствующих задатчиков ввести значение толщи-

ны образца и температуры окружающей среды. 
7. Наблюдать и анализировать по виртуальным осциллографам изменения температур на гранях образца, теплового 

потока и значения теплопроводности. 
8. Когда температуры и тепловой поток станут постоянными во времени (или почти постоянными), записать в табл. 

14.2 значение теплопроводности и режимных параметров. 
9. Увеличить напряжение питания нагревателя ИТ-4 до 30 В и повторить п. 7, 8. 
10. Остановить программу, выключить компьютер и лабораторную установку.               

 

№ Название 
материала 

Температура 
воды в  

термостате, °С 

λ, 
Вт/(м⋅K) δλ, % 

Средняя  
температура  
образца, °С 

1  25    
2  40    

 
Содержание отчета 

 

1. Название работы, цель. 
2. Структурная схема лабораторной установки (на основе рис. 14.3). 
3. Табл. 14.2 с экспериментальными и расчетными данными. 
4. Выводы. 
 
Контрольные вопросы 

 

1. В каких единицах измерения происходит определение величины плотности теплового потока? 
2. Почему перед правой частью уравнения (14.1) стоит знак «минус»? 
3. С помощью какого метода происходит определение коэффициента теплопроводности в данной работе? 
4. Из каких основных частей состоит прибор ИТ-4? 
5. Какие функции выполняет крышка прибора ИТ-4? 
6. Почему к испытанию не допускаются образцы с выпуклой или вогнутой поверхностью? 
7. Как задается температурный режим измерений? 
8. Почему при увеличении ориентировочного значения  теплопроводности повышают рекомендуемые значения тол-

щины и диаметра образца? 

Таблица 14.2 



 

9. Что такое дифференциальные термоэлектрические преобразователи и как их можно использовать для измерения тепло-
вых потоков? 

10. Из каких основных функциональных блоков состоит лабораторная установка? 
11. Какие функции выполняет плата сбора данных в составе персонального компьютера? 
12. Как повлияет на экспериментальные данные изменение температуры окружающей среды? 
13. Докажите теоретически,  что относительная погрешность измерения теплопроводности не зависит (или зависит) от 

напряжения питания. 
14. Как повлияет на относительную погрешность измерения теплопроводности изменение доверительной вероятности? 
15. Вычислите значение доверительного интервала для заданной доверительной вероятности. 
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